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| Chapter 1
Introduction to Computer

Learning Objectives:

After completion of this chapter, you should be able to:

NI

. Define the term computer, and describe the relationship between data and information.

Describe the five components of a computer: input devices, output devices, system

unit, storage devices, and communications devices.

3. Distinguish between system software and application software.

Differentiate among types, sizes, and functions of computers in each of these
categories: personal computers (desktop), mobile computers and mobile devices, game
consoles, servers, mainframes, supercomputers and embedded computers.

Explain how home users, small office/home office users, mobile users, power users,
and enterprise users each interact with computers.

Discuss how society uses computers in education, finance, government, health care,

science, publishing, travel, and manufacturing.
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1. Computer Definition

A computer is an electronic device, operating under the control of
instructions stored in its own memory, that can accept data, process
the data according to specified rules, produce results, and stores the

results for future use.

2. Data and Information

Data is a collection of unprocessed items, which can include text, numbers, images, audio, and video.
Information conveys meaning and is useful to people.

Computers process data (input) into information (output). Computers carry out processes using instructions,
which are the steps that tell the computer how to perform a particular task. A computer often holds data,

information, and instructions in storage for future use.

3. The Components of a Computer

A computer contains many electric, electronic, and mechanical components known as hardware. These
components include input devices, output devices, a system unit, storage devices, and communications

devices.
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3.1 Input Device
An input device is any hardware component that allows you to enter data and instructions into a computer.

Five widely used input devices are the keyboard, mouse, microphone, scanner, and Web cam.

1. Keyboard: A computer keyboard contains keys you press to
enter data into the computer. For security purposes, some

keyboards include a fingerprint reader, which allows you to work

with the computer only if your fingerprint is recognized.

2. Mouse: A mouse is a small handheld device. With the mouse, you control movement of a small

symbol on the screen, called the pointer, and you make selections from the screen.

3. Microphone: A microphone allows you to speak into the computer.

4. A scanner: converts printed material (such as text and pictures) into a form the -
computer can use. 6

5. A Web cam: is a digital video camera that allows you to create movies or take f
pictures and store them on the computer instead of on tape or film.

3.2 Output Device
An output device is any hardware component that conveys information to one or more people. Three
commonly used output devices are a printer, a monitor, and speakers.

1. Printer: produces text and graphics on a physical medium such as paper.

2. A monitor: displays text, graphics, and videos on a screen.

3. Speakers: allow you to hear music, voice, and other audio (sounds).

3.3 System Unit

The system unit is a case that contains the electronic components of the computer that are used to process
data. The circuitry of the system unit usually is part of or is connected to a circuit board called the
motherboard.

Two main components on the motherboard are the processor and memory.
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1. The processor: also called a CPU (central processing unit) is the electronic component
that interprets and carries out the basic instructions that operate the computer, it

determines the speed of computer which measured by Hz.

2. Memory: consists of electronic components that store instructions waiting to be
executed and data needed by those instructions. Although some forms of memory are

permanent, most memory keeps data and instructions temporarily, which mean its

contents, are erased when the computer is shut off such as RAM.

3.4 Storage Devices
Storage holds data, instructions, and information for future use. Storage devices often function as a source of
input because they transfer items from storage to memory. The size of storage devices usually measured by

Megabytes and Gigabytes. Examples of storage media are:

1. A USB flash drive is a portable storage device that is small and lightweight enough to be transported on

a keychain or in a pocket. The average USB flash drive can hold about 4 billion characters.

2. A hard disk provides much greater storage capacity than a USB flash drive. The
average hard disk can hold more than 320 billion characters. Hard disks are enclosed in
an airtight sealed case. Although some are portable, most are housed inside the system
unit. Portable hard disks are either external or removable. An external hard disk is a

separate, freestanding unit, whereas you insert and remove a removable hard disk from the

computer.

3. An optical disc is a flat, round, portable metal disc with a plastic coating. CDs, DVDs, and Blue-ray
Discs are three types of optical discs.

= CD: can hold from 650 million to 1 billion characters.

= Some DVDs can store two full-length movies or 17 billion characters. i e

= Blue-ray Discs can store about 46 hours of standard video, or 100 billion characters.

4. Some mobile devices, such as digital cameras, use memory cards as the storage media. You can use a

card reader/writer to transfer the stored items, such as digital photos.
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3.5 Communications Devices
A communications device is a hardware component that enables a computer to send
(transmit) and receive data, instructions, and information to and from one or more

computers or mobile devices. A widely used communications device is a modem.

4. Computer Software
Software, also called a program, consists of a series of related instructions, organized for a common purpose,

that tells the computer what tasks to perform and how to perform them.

4.1 Program Interface

You interact with a program through its user interface. The user interface controls how you enter data and
instructions and how information is displayed on the screen. Software today often has a graphical user
interface (GUI). With a graphical user interface, you interact with the software using text, graphics, and
visual images such as icons. An icon is a miniature image that represents a program, an instruction, or some

other object. You can use the mouse to select icons that perform operations such as starting a program.

4.2 Software Categories
The two categories of software are system software and application software.
1. System Software:
System software consists of the programs that control or maintain the operations of the computer and its
devices. It serves as the interface between the user, the application software, and the computer’s hardware.
Two types of system software are the operating system and utility programs
= An operating system is a set of programs that coordinates all the activities among computer hardware
devices. Many of today’s computers use Microsoft’s Windows, or Mac OS, Apple’s operating system.
= Utility Program: A utility program allows a user to perform maintenance-type tasks usually related to

managing a computer, its devices, or its programs.

2. Application Software
Application software consists of programs designed to make users more productive and/or assist them with

personal tasks. Such as Web browser, word processing software.
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4.3 Installing and Running Programs

Installing and Running a Computer Program

Step 1: INSTALL - Step 2: RUN ~
When you Insert 3 program disc, such as 3 photo Once Installed, you can Instruct the computer to
editing program, in the optical disc drive for the run the program. The computer transfers instructions

first tme, the computer begins the procedure of
installing the program on the hard disk.

from the hard disk to memory

Step 3: USE = )
The program executes so that you @an use it
This program enables you 1o edit photos.

4.4 Software Development

A programmer or developer writes the instructions that direct the computer to process data into information

using programming language such as C++, Java, JavaScript, Visual C#, and Visual Basic.

5. Categories of Computers

Computers are classified in to seven categories according to size, speed, processing power, and price.

Category(1) | Personal computers (Desktop)
Physical Size | Fits on a desk
Price Range | 100-1000 dollars
Designed to run especially commercial software (as a word processor or Internet
Usage browser) for an individual user.
Image
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Category(2) | Mobile computers and mobile devices
Physical Size | Fits on your lap or in your hand
Price Range | >100 - 1000 dollars
= For personal information management such as a calculator, and a notepad.
= Internet-enabled device; allows you to send and receive mails, read e-books.
Usage = Serve the needs of mobile employees, such as meter readers .
Can be: A laptop, Tablet PC, Smart phone, PDA (personal digital assistant,
E-Book Readers and Handheld Computers.
Image
Category(3) Game console
Physical Size | Small box or handheld device
Price Range Several hundred dollars or less
U Designed for single-player or multiplayer video games. Two popular models
sage . . :
are: Nintendo DS Lite and Sony’s PlayStation Portable (PSP).
Image
Category(4) Server
Physical Size | Small cabinet
Price Range | Several hundred to a million dollars
U = Controls access to the hardware, software, and other resources on a network.
sage . . : .
= Provides a centralized storage area for programs, data, and information.
Image
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Category(5) Mainframe
Physical Size | Partial room to full room of equipment
Price Range | $300,000 to several million dollars
Usage = Store tremendous amounts of data, instructions, and information.
= Most major corporations use mainframes for business activities.
Image
Category(6) Super computers
Physical Size | Full room of equipment
Price Range | $500,000 to several billion dollars
= Applications requiring complex, sophisticated mathematical calculations.
Usage = Large-scale simulations and applications in medicine, aerospace.
= Online banking, weather forecasting and nuclear energy research.
Image
Category(7) Embedded computers
Physical Size | Miniature
Price Range Embedded in the price of the product
products that contain embedded computers:
= Consumer Electronics: mobile and digital telephones and digital televisions.
Usage = Home Automation Devices: security monitoring systems and lights.
= Automobiles.
Image
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6. Examples of Computer Usage

There are five categories of users:

User

Hardware

Software/Usage

Home Users

Desktop or notebook
Smart phone
Mobile device

Game console

Business

Personal finance, online banking
Web browser

Email, chat, online social networking
Internet telephone call

Education, Entertainment

Desktop or notebook
Smart phone

Mobile device

Shared network printer

Business

Company specific(Ex. Accounting)
Network management

Web browser

E-mail

Internet telephone calls.

Notebook equipped with
a wireless modem.
Tablet PC

Video projector

Smart phone

Handheld game consoles

Business
Personal information management
Web browser

E-mail

Workstation or other
powerful computer with
multimedia capabilities.
Smart phone or other

mobile devices.

Desktop publishing

Multimedia authoring

Photo, audio, and video editing
Personal information management
Web browser

E-mail

Server or mainframe
Dektop or notebook
Industry-specific
handheld computer

Smart phone or other
mobile devices.

Business

Personal information management
Accounting

Network management

Web browser

E-mail
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7. Computer Applications in Society

People interact directly with computers in fields such as:

Medical Systems Government Systems

Manufacturing Systems Financial Systems

N
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Chapter 2
7 Introduction to Windows 7

Learning Objectives:

After completion of this chapter, you should be able to:

1. Learning how to turn on and shut down your computer.

2. Explore the desktop and task bar of your computer.

3. Explore the control panel and learn how to change different setting of the windows
environment.

4. Learning how to work with files and folders in your computer.

5. Learn how to get help and support to deal with your PC.
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1. Turning on the computer
1. plug computer in the power point at the wall then push the power button on the front of the machine.
2. Check that the monitor is turned on (a green light will show on the monitor).

1.1. Logging on
Press the three buttons: CTRL-ALT-DELETE at the

same time.

CHRS ey

Enter your USERNAME and PASSWORD into the window that appears.

1.2. Good Password Practices

You must change your password every 60 days. Your password must:

= be between 6 and 8 characters in length (inclusive)

= De easy to remember

= Not be your first name, surname or login.

= Not be a single real word e.g. book.

= Not be "gwerty" or something similar, as it is amongst a hacker's favorite first attempts.
Good Password Examples:

« tacOsnax : 8 characters, no real words, but easy to remember.

» P@sswOrd: use numbers or special characters instead of letters in words, ("&","1","#").
+ 1000380Kor easily remembered keyboard patterns instead of words.

2. Introduction to the Desktop

Your DESKTOP is what you now see on the screen.

Start
Button
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2.1. Desktop Customizations

View 3

To customize your desktop make right click on an empty place in your desktop, Sy .

Refresh

a dropdown menu will be appear as in the next picture:

Paste

Now you can make changes in your desktop appearance by choosing one of the Faste sherteut

. Eaea | i Lk
following: Pl il ,
Mew »

B2 Screen resolution

W5 Gadgets
& Personalize

1. Screen resolution:

It is the setting that determines how much information

displayed on the computer screen, measured horizontally | =5 B e e

and vertically in pixels. Such as 640 x 480 or 1600x1200. =

Change the appearance of your display

Display: 1. Mobile PC Display +

Resolution: [1280 = 800 (recommended) v]

Advanced settings

Connect to a projector (or press the & key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

[ OK ][ Cancel ]l Apply

2. Gadgets:
They are mini-programs which offer information at a glance and provide easy access to frequently used
tools. For example, you can use gadgets to display a continuously updated weather status. Some of the
gadgets that come with Windows 7 are Calendar, Clock, Weather, Feed Headlines, Slide Show, and

Picture Puzzle.

=

Calendar CPU Meter Currency

Fomm >
|

Picture Puz s Slide Show Weather Windcm_:s Media. 3

o Get n

3. Personalize
You can add a personal touch to your computer by changing the computer's theme, color, sounds, desktop
background, screen saver, font size, and user account picture.


mshelp://windows/?id=883aab11-e886-4982-aa3c-33fbf1748e71#gtmt_theme_def
mshelp://windows/?id=5692cd60-bb26-48af-8980-485070feed51#gtmt_desktop_def
mshelp://windows/?id=d3b6dcfe-f35e-49b0-9c53-a258f8ea84ea#gtmt_gls_screen_saver_def
mshelp://windows/?id=5bcd85c0-892a-4ca1-a2d9-7864aaf107d0#gtmt_gls_font_def
mshelp://windows/?id=ca5d36ab-2fa7-49bb-bcc1-fe25cae5fef4#gtmt_user_account_def
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=  Themes

A theme includes a desktop background, a screen saver, a window border color, sounds, and sometimes
icons and mouse pointers. Use the whole theme or create your own customized theme by changing the

pictures, colors, and sounds individually.

O B ) Control Panel »

File Edit View Tools Help

Control Panel Home
Change the visuals and sounds on your computer

Click a theme to change the desktop background, window color, creen saver all at once.

My Themes (16)

1#"? o O

d Theme Beautiful Bird: Bing's Best 2 Echoes of the Past FreshFruit ~ Harvest Time

EFFF BT F.

TwinkleWish ~ Wieliczl

I

Get more themes online

=t , <

Desktop Background Window Color Sounds Screen Saver
\ccess Center Harmony Sky Windows Default None

= Desktop background: The desktop background, also called wallpaper, is a picture, color, or
design on the desktop. It provides a backdrop to your open windows. You can choose one picture

to be your desktop background or you can display a slide show of pictures.

« Abstract (6)

J'~~~ vy | 7 7 .
, ‘
*"’“ M u& - “

* Architecture (6

* Characters (6
/) - v y J) x
- o B3

= Window Color: allows you to change the color your window frames, the Start menu, the taskbar,

and more.


mshelp://windows/?id=332d7acf-bb07-4e33-8adb-bc8bd6c4477c#gtmt_window_def
mshelp://windows/?id=e18cb038-4ac9-42ad-af03-4af222c12a11#gtmt_icon_def
mshelp://windows/?id=332d7acf-bb07-4e33-8adb-bc8bd6c4477c#gtmt_window_def
mshelp://windows/?id=c902cf44-35da-46f6-972d-59a8fe055898#gtmt_taskbar1_def
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= Sounds: You can change the sounds your computer makes when, for example, you receive an

e-mail message, start Windows, or shut down the computer.

= Screen Saver: A screen saver is a picture or animation that appears on the screen when you
haven't used the mouse or keyboard for a set period of time. You can choose from a variety of

Windows screen savers.

2.2. Working with Icons
Icons are small pictures that represent files, folders, programs, and other items.
1. Glossary of Icons:
My Documents
= The default storage folder for your files that you create. When you save or open a file,
= Microsoft Windows initially opens the MY DOCUMENTS dialog box.

~ 7
My Computer
Displays information about your computer, such as the contents of your computer drives and
FI 1

L which printers you have installed. It also allows you to find, view and organize files.
—

The Recycle Bin

= Any file you delete from your hard drive will be placed first in the it.

]

)
-

2. Arranging lcons on the Desktop

View

Sort by » Name

The different options for arranging icons are:

a. by name
. Refresh Size
b. by size - e
C. by type I Paste shortcut Date modified
d. When last modified. Py Al pailash.

. . . gl SIS »
To access these options, right mouse click on a free spot

New >

anywhere on the desktop.

[ Gadgets

B2  Screen resolution
U=
& Personalize

3. Changing the Icon

To change the image or graphic used do this:
- Right click on the icon > PROPERTIES->SHORTCUT tab->CHANGE ICON.
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4. Changing the size of the icons
Click and hold down the Ctrl key and then use your scroll wheel on your mouse to resize the icons.

5. Shortcuts

You can create your own icons on the desktop to enable faster access of programs, folders, documents,
printers etc. These are called SHORTCUTS.

You can tell if an icon is a SHORTCUT or not by its appearance. If it has a little black arrow [;]LQ
on the icon, then it isa SHORTCUT. &ﬂ?@
To create shortcut: Right mouse click on an empty part of the desktop> NEW ->SHORTCUT.

3. The Taskbar

3.1. Taskbar Sections

The taskbar is the long horizontal bar at the bottom of your screen. It has three main sections:

P

-l

L3 ) : .
1. The Start button , Which opens the Start menu: The START gives you access to most things
available on your computer, some of the items you may see in the START Menu are: Documents,

Pictures, Music, Computer, Control Panel and more.

2. The middle section, which shows you which

programs and files you have opened and allows you to
quickly switch between them.

3. The notification area, which includes a clock and icons
(small pictures) that communicate the status of certain = = ) 1205PM |
programs and computer settings. Occasionally, an icon in the =
notification area will display a small pop-up window (called a  The notification area of the taskbar
notification) to notify you about something. For example, after adding a new hardware device to your

computer, you might see this.

. USB Input Device N X
Device driver software installed successfully.

The notification area displays a message after new hardware ts installed
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3.2. Customize the taskbar

There are many ways to customize the taskbar to suit your preferences such as:

1. To unlock the taskbar : Right-click an empty space on the taskbar. If ‘Lock the taskbar’ has a check
mark next to it, the taskbar is locked. You can unlock it by clicking ‘Lock the taskbar’.

2. To move the taskbar: Click an empty space on the taskbar, and then hold down the mouse button as
you drag the taskbar to one of the four edges of the desktop. When the taskbar is where you want it, release
the mouse button.

= fron ~=
4. COﬂtFOl PanEI v | 43 | |Seorch Control Panet e I
You can use Control Panel to change
Category ¥
settings for Windows.
User Accounts and Family Safety
V. . By Add or remove user accounts
Ul By Set up parental controls for any user
Appearance
% Change desktop background
Adjust screen resolution
q Clock, Language, and Region
L Change keyboards or other input methods
The different Parts of control panel described below:
> To view and change system and security status, back up and restore
System and '.v.' _ _ _
LB 3 file and system settings, update computer, view RAM and processor
Security '

speed, check firewall and more.

- To check network status and change settings, set preferences for
Network and @. o ) ) )
—, sharing files and computers, configure internet display and
Internet

connection.

Hardware and To add or remove printers and other hardware, change system sounds,

&

Sound play CD's automatically, conserve power, update device drivers.
e Uninstall programs or windows features, uninstall gadgets, get new
Programs b4 )
LW programs from the network or online.
Change user account setting and passwords, and set up parental
User Accounts
controls.
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Appearance and Change the appearance of desktop items, apply a theme or screen

Personalization saver to your computer, or customize the Start menu and taskbar.

Change the date, time, and time zone for your computer, the language
Clock, Language

) to use, and the way numbers, currencies, dates, and times are
and Region

displayed.

| @| #

Adjust your computer settings for vision, hearing, and mobility, and

Ease of Access use speech recognition to control your computer with voice

commands.

4.1. What software versions do | have and what is on my computer?
There are several versions of Microsoft Windows in existence. You may have heard of:: Windows XP,
Windows Vista and Windows 7.

You can tell what version you have (either at work, or at home) by:
1. Find the MY COMPUTER icon on the desktop.
2. Right mouse click on this icon and select PROPERTIES from the shortcut menu. Then you can see what

version of Windows you are currently operating in.

- (_)g™ » Control Panel » System and Security » System

File Edit View Tools Help

Control Panel Home T— .
Uiew basic information about your computer

) Device Manager Windows edition

%) Remote settings Windows 7 Ultimate
% System protection Copyright © 2009 Microsoft Corporation. All rights reserved.

Service Pack1

@) Advanced system settings

Rating: ,’! Your Windows Experience Index needs to be refreshed
Processor: Intel(R) Core(TM) Duo CPU  T2400 @1.83GHz 1.83 GHz
Installed memory (RAM): ~ 1.00 GB

System type: 32-bit Operating System

Pen and Touch: No Pen or Touch Input is available for this Display

Computer ain, and workgroup settings

Home-PC @ Change settings
Home-PC

'WORKGROUP

Windows activation
Windows is activated
Product ID: 00426-OEM-8992662-00006

4.2. What system configuration you have?
The Device Manager can tell you this by clicking on the DEVICE MANAGER link on the left of system

properties window.

18

L
\
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The DEVICE MANAGER Dialog box has a list of devices attached to your PC.

¢ Device Manager

File Action View Help
=@ HmEl S

4 == Home-PC

e 259 Batteries

- M Computer

g Disk drives

- -y Display adapters

B \3«, DVDYCD-ROM drives

> L’L':“, Human Interface Devices

g IDE ATASATAPI controllers

- = Keyboards

> }3 Mice and other pointing devices

& Modems

B Monitors

¥ Metwork adapters

[ 53 Intel(R) PRO/100 VE Metwork Connection
H I-TIF Intel(R) PRO/Wireless 30454ABG Metwork Connection
. 1] PCMCIA adapters

B D Processors

B -3y Sound, videc and game controllers

s (M Systermn devices

- @ Universal Serial Bus controllers

e

5. Help and Support

Help is always available about the different functions on your computer. You can access the help function
by clicking START button> HELP AND SUPPORT.

r@ Windows Help and Support . EIEI—J&
@ &) a® = [l 53 2 options -

|Rest|:|re files frem recycle bin | pel |
=

=
Best 20 results for Restore files frm
1. Recover files from the Recycle Bin

anently delete files from the Recycle Bin

Stepl: Enter the search

Show or hide the Recycle Bin

4. Recover lost or deleted files

criteria in the search box

Change the Recycle Bin settings

Step2: Click on a

topic.

elete files using Disk Cleanup

Delete a file or folder

8. The desktop (overview)
9. How does Windows choose which files to back up?
10. Woerking with files and folders
11. Add or delete desktop icons
12. Libraries: frequently asked questions
13. Show, hide, or resize desktop icons
14. Show or hide common icons on the desktop
15. Mowve and copy files using drag and drop

Q More support options

&P Online Help ~

(S

=

You can also hit F1 on your keyboard at any time to launch the HELP menu. You need to click on the
desktop first then press F1.

6. Windows
6.1 Window Definition

A window is a boxed area in which you view programs, files, folders, drives, icons representing programs,
and other elements. Here's a window and each of its parts:
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Navigation pans Column headings

Back and Forward buttons File it

Toolbar  The search box

0 0 N

Address bar Details pane

0 (B W NG

Library pane

1. Navigation Pane:
Use the navigation pane to access libraries, folders, saved searches, and entire hard disks.

2. Back and Forward Buttons:

Use the Back buttong and the Forward button@ to navigate to other folders or libraries you've already
opened without closing the current window.

3. Toolbar:

Use the toolbar to perform common tasks, such as changing the appearance of your files and folders,
burning files to a CD, or starting a digital picture slide show.

4. Address bar:

Use the address bar to navigate to a different folder or library or to go back to a previous one.

5. Library pane:

The library pane appears only when you are in a library (such as the Documents library). Use the library
pane to customize the library or to arrange the files by different properties.

6. Column headings:

Use the column headings to change how the files in the file list are organized. The column headings are
available only in Details view.

7. File list:

This is where the contents of the current folder or library are displayed.

8. The search box:

Type a word or phrase in the search box to look for an item in the current folder or library.
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9. Details pane:

Use the details pane to see the most common properties associated with the selected file.

10. Preview pane:

Use the preview pane to see the contents of most files without opening it in a program. If you don't see the

preview pane, click the Preview pane button in the toolbar to turn it on.

6.2. Working with windows
1. To make a window fill the entire screen, click its Maximize button WEN

2. Toreturn a maximized window to its former size, click its Restore button

3. To resize a window (make it smaller or bigger), point to any of the
window's borders or corners. When the mouse pointer changes to a
two-headed arrow, drag the border or corner to shrink or enlarge the

window.
4. To minimize a window, click its Minimize button @
5. To close a window, click its Close button @
6. To switch between opened windows press Alt+Tab.

7. To arrange windows automatically, you can arrange them in one of three ways: cascading, vertically
stacked, or side by side.

- AR = & me=

To choose one of these options, open some windows on your desktop, then right-click an empty area of

the taskbar and click Cascade windows, Show windows stacked, or Show windows side by side.

7. Dialog Boxes

Dialog Boxes are special windows where you are asked to give details and select options. The choices you
make are then sent as commands to the software you are using.

The following is an example of a Dialog Boxes:
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Paragraph

Indents and Spadng I Line and Page Breaks

General

Aignment:  |ENETZN] ~ |
Qutline level: |Body Text E

HELP button

Indentation
Left: 0am = Special: By:
Right: Oam = (none) El =

- Mirror indents
Check boxes Drop Down or

Spadng Pull Down Menu
Before: Opt e Line spacing:
After: 12pt |2 Single

7] Don't add space between paragraphs of the same style

Preview

[ Tabs... [ set As Default | [ ox ][ cancel |

J

Dialog boxes vary in appearance but some typical options and their uses are:

1. Check boxes: are selected if there is a tick in them.

2. Tabs: allow several dialog boxes to be in the one area.

3. Drop Down or Pull Down Menu: has a downward pointing arrow next to it
4. Help Button: is a handy help tool. The keyboard shortcut is SHIFT + F1.
5

Radio Buttons: clicking in a radio button selects it.

Fage range
It is a choice button and only one in the series can @ al
iy k i
be selected. J\ e
I i Pages: | \
] ) \_ ) \— Text Box or
6. Field or Text Box: is an area where you have to Radio Field
. . buttons
type information.
7. Slider: is a button you click and drag either to left or right to Scigsniiseoliiion
Lezs _J— R ore
change a setting. 1024 by 7EE pivels
8. Spinner: looks like miniature scroll bars.
Number of copies: 3 ]

9. Command Buttons: When you click on or accept a Command button, a command is passed on to

the software you are using.

[ ok || cancel |
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a. OK - Used to accept any changes you have made to a dialog box.
b. CANCEL - Cancels any changes you have made and returns you to the main window of the

software you are using.

10. List Boxes: are lists of items in a box. Clicking on an item E;m”“* .
1 1 _"icsu‘lﬂ?-l 1
with the mouse selects that item. -

oz backgoued 102467 EE

8. Folders and File Management Attty
Windows Explorer is one area where you can view the file structure of your computer.

8.1. Open Windows Explorer

You can access WINDOWS EXPLORER a number of ways. The most & p e i
common ways are. ’E Open Windows Explorer

1. Right click on the START Menu - OPEN Windows EXPLORER.
OR

2. Click on the WINDOWS EXPLORER icon on the TASK BAR.
OR :

3. Click START button>PROGRAMS->ACCESSORIES>WINDOWS EXPLORER.
When you open up WINDOWS EXPLORER, you will see the following window:

- —

| —— =18
(I [& » vibraries »
File Edit View Tools Help
Organize v New library =~ 0 @
¢ Favorites Libraries
B Desktop Open a library to see your files and arrange them by folder, date, and other properties.
8 Downloads = o]
% Recent Places &| Documents ‘ﬁ Music W Pictures 8 Videos
= ks Library Library Library &l Library
< <& << <
i Libraries
[¥ Documents
& Music
B Videos
1% Computer .
&, Local Disk (C) nght Pane
a University (D:)
a Entertainment (E:)
€ Network

Navigation pane

4 items

8.2. Use Libraries to Find Files

Libraries are a new way to see your files. Libraries are not folders but areas to locate and find your files.
They don’t store your files but gather the files in a way for you to easily locate them.
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The four Libraries are: g
1. Documents. -
2. Music. @\j' <] » Libraries » Docum:
3. PICtUI’eS : Organize = Share with » B
4. Videos. ‘
4 .U Favorites
. . . . . Bl Desktop
Here are some other things you can do with libraries using the 8 Downloads
navigation pane: N BEcent 1 iuces
1. To create a new library: right-click Libraries, point to New and then || | i
H H ’ = Documents
click Library. e
2. To move or copy files from the file list to a library's default save g 3:;:
location: drag the files to the library in the navigation pane. | X
a5 omputer
3. To rename a library: right-click it->Rename—> type a new name-> &, Local Disk (C)
Enter. € Network

4. To see the folders those have been included in a library: double-click the library name.

5. To remove a folder from a library: right-click the folder that you want to remove, and then click
Remove location from library. This only removes the folder from the library; it doesn't delete the folder
from its original location.

6. To hide a library: right-click the library and then click Don't show in navigation pane. This is a good
solution if you're running out of space in the navigation pane but don't want to delete a library.

7. To show a hidden library: click Libraries, right-click the library in the file list, and then click Show in

navigation pane.

€| Extra Large Icons

| Large Icons

8.3. Change thumbnail size and file details

+ 5 Medium Icons

You can change the size and appearance of your files and folders by using

| Small Icons
the Views button located on the toolbar of every open folder. =
== Details
= Tiles

= Content

The Views menu

8.4. Selecting Files and Folders

Before you move, copy or delete files and folders, they must be selected so that Windows (and the
computer) knows which files and folders to work with.

In WINDOWS EXPLORER, you can select multiple files and folders by combining the use of the keyboard

with the mouse:
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1. Single Selection: point your mouse over the item you want to select and click once. The item will be
highlighted (usually blue highlight)

2. Scattered Selection: hold down the CTRL key and then click on each item you want to select.

3. Block Selection: click on the first item you want to select, hold down the SHIFT key and then click the
last item to be included in the selection

4. Selecting All: To select everything in a folder, use the EDIT MENU->SELECT ALL option, or they
keyboard shortcut CTRL+A.

8.5. Files Name and Path
Files are documents which have been created using different software applications.
1. File Extension: A filename consists of a descriptive name to describe the contents and a few letters file
extension which follows the name of the file. This extension indicates the type of application used to create
the document. Some common file extensions are:

= .doc, .docx : Microsoft Word files

= XxlIs: Microsoft Excel files

= .pdf: Adobe Acrobat files

= .ppt: Microsoft PowerPoint files

JPG, .Bmp: Image File
= .Mp3: Audio File
These extensions are automatically added to your filename when you save your file.
2. File Paths:
All files have a path name. This gives you (and the computer) the exact details of which drive and which
folder(s) the file(s) are located in.

C:8kills101 \marks.doc

Dirive Name Folder name File Name

8.6. Renaming Files and Folders
You can rename by using the FILE menu-> left mouse button—> Select RENAME .
8.7. Deleting Files and Folders
To delete a file or folder:
= Right-click the file or folder that you want to delete, and then click Delete.
= To permanently delete a file or folder, hold down the SHIFT key, press delete on the keyboard.

Files and folders from diskettes, drives etc. cannot be recovered.
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8.8. Folder and File Attributes

Files and folders have property sheets which display information such as size and location.
To determine the attributes of a file or folder:

Select the file or folder—> Right click on the file or folder—> Select Properties.

,
e =

General |S-E>4.:|J|'i’r).r I Custom I Details I Previous Versionsl

@ GuiBn & la doc

Type of file: Microsoft Word Document {.doc)

I Opens with: @ Microsoft Office Word I
Location: CUsers  Home Desktop
E— Size: 29.5 KB (20,208 bytes)

Size on disk: 32.0 KB (32.768 bytes)

Created: Sunday. October 06, 2013, 4:27:08 PM I
Modified: Sunday, October 06, 2013, 4:35:21 PM
Accessed: Sunday, October 06, 2013, 4:35:21 PM

Attributes: [[] Read-onty  [] Hidden

The PROPERTIES dialog box gives you the following information:

1. Type of File: tells you what program your file was created in (e.g. Word)
2. Opens with: tells you what application (software) the file will open in
3. Location: the path name for the file
4. Size: the size of the file
5. Size on disk: how much room the file is taking in storage
6. Created: the date and time the file was originally created
7. Modified: the date and time the file was last modified
8. Accessed: the date and time the file was last accessed
9. Hidden: Usually hidden files are program or system files that should not be deleted or changed.
10. Read Only: A read only file on your computer is a file you can open, read or print but not make any
changes to.
8.9. Restoring Deleted Files
1. Open the recycle bin =
2. Do one of the following: -.:'p
= Torestore a file, click it, and then, on the toolbar, click Restore this item. =
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= To restore all of the files, make sure that no files are selected, and then, on the toolbar, click Restore

all items.

The files will be restored to their original locations on your computer.

I}; » Recycle Bin

v Empty the Recycle Bin

rites

iktop
~nloads
ent Places
ries

suments

8.10. Emptying the Recycle Bin:

Restore this item

Invoice
Text Document

3.1 KB

Letter for Heidi

ocument

65.1 KB

1. Select the RECYCLE BIN in the FOLDER LIST of WINDOWS EXPLORER,;

2. Click on the FILE menu;
3. Select EMPTY RECYCLE BIN;
4. Click on YES to confirm.

9. Shutting Down or Logging off a Computer
You SHUT DOWN your computer or LOG OFF when you have finished using it.

Closing Opened Applications:

Before you can do either of these functions, any applications you have open must be closed. This is done by

either:

= Clicking on the File menu within the application >select EXIT or press ALT + F4.
= Click on the CLOSE button located on the top right hand side of the application.

= You should also remove any USB drives from the computer. Open up Windows Explorer; locate the

USB drive name in the FOLDER LIST. When you have located it, right mouse click on it and select

EJECT from the shortcut menu. This will ensure that the drive is removed correctly without

damaging any files it contains.

Now you can choose one of these actions:

Log off
Lock

Restart

Sleep

a. Log Off: Means that you log off as a User without turning the computer off. Someone else can then log

on. This can do by:
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Click on the START button—>Select LOG OFF.

If you have any open programs then you will be asked to close them down or to let Windows, Force

them to shut down. You will lose any un-saved information if you do this.

b. Shut Down: Means that you log off as a User and the computer is turned off at the same time. You will
lose any unsaved information's.

c. Restarting your Computer: Restarting your computer means that the computer logs you off the system,
turns itself off and turns itself back on again so you can re-log on.
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A Microsoft Word 2010

Learning Objectives:

After completion of this chapter, you should be able to:

Ok wnhE

o

8.
9.

Describe Word 2010 Environment, such as: tabs, groups and commands ... etc.

Identify the meaning and function of The Ribbon, The Quick Access Toolbar

Use the Backstage view (The File tab) functions, such as save, new, print... etc.

Use the groups in Home Tab to format, edit, find and replace words a document,

Use the Insert Tab to insert a picture, clipart, shape, textbox, header & footer, symbols ...
etc.

Use the Page Layout Tab to add Themes and setting up the document.

Know how to insert a Table of contents, footnotes and endnotes to a document from the
References Tab.

Check the document’s spelling and grammar by using the Review Tab.

Use the View Tab to view the document, in addition to zoom in and zoom out options.

10. Describe the Auto correction steps.
11. Know the keyboard shortcuts being used in word.
12. Recognize the available options in the some important dialog boxes.

l’..

Microsoft’ —J

Offlce

2010
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1. Introduction to Word 2010 Environment

Word 2010 is a word processor that allows you to create various types of documents such as letters, papers,
flyers, faxes and more.
Quick Access Toolbar File Name.docx Minimize — Maximize - Close

mf| FIERRCARN G, Rbdallah.doct|f Microsoft Word

Home Insert Page Layout References Mailings Review View ‘_ Tabs

@ 4 Calibri (Body) i1 - E-iELiDe EE "
Ly B I U -abe x, x & ==. *=. &Jﬁ

Faste - o — . Quick Change | Editing
- J| &P é'ﬁh' A A MW Q' |4 M styles~ styles - =
Clipboard s | K *‘ Font i Paragraph Styles [ |
L] T | S
[l 'r []
Some groups have -
an arrow for more
options
,“‘J
I e O
Hlnsertion Point

'| -

o +

Views: Current Zoom Button

- Page #of Words U e}

- # Pages Count view is highlighted Zoom Slider =

4] * ? 'j i | f El

Page:3 of 5 | Wordsi0 | ¥ English (U.s) | Status Bar BE& = =| 120% (5 () (¥) .
1.1. Backstage view (The File tab) “—

. o =l Save
Save: allow you to save documents. The document will be saved in its current B save As
location with the same file name. &
7 Open
Save As: Allow you to save a file in different name or location or version (e.g. (i Close
Word97-2003) or format (e.g. PDF) while keeping the original.
Open: Opens an Existing Document Recent
Close: Closes the document. New
Recent: To access recently opened files. Print
New: Create a new document Save & Send
Print: Allows you to print the document. Help
Exit: Closes all opened files and exits word ] Options
Exit
Mlcrosnf.t'd—"-J-
Office
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1.2. The Quick Access Toolbar

Let you access common commands. By default, it shows the Save, Undo, and Repeat commands. You can add

other commands to make it more convenient for you.

_]' Home | Customize Quick Access Toolbar !nce

Word Options _ =)
= -4 New &
j 2 Cat Open ¢ vt @ Customize the Quick Access Tooka,
ste P B J Save st Chease commands e Customae Quck Azceds Toobae )
G/ ‘ A Prestie o Conmanss  [v] fordtgomirtienn ]
03rd | E-mail Sove , .
: Quick Print P Weguage j ::T;"“:':M 7 'g ::; ’
Print : Aduanies B Quamet !u Reco
| Add to Quick Access Tool;] A Quaspe 2 3 QukkPret
Sp ellifryee Customaze REdaon ™ E l
Undo || ] | e
@ Redo Astdng Bl swess
bt 5} Save Selectonto Test Box Gal. —
Draw Table 15 SeNombering Ve ~ e (roa~ ]
T Saom Quick Access Toaibae belew the Cutoacioone: Wulodzal®
Open Recent File ' voy (imgotmed =)
More Commands... et w ] ’
Show Belowthe Ribbon | )
A. Saving
(W] Save As ' —
®_Ov <] » Libraries » Documents » - | +4 | 1 Search Documents ol
Organize = Mew folder =~ @
°  Documents library
Arrange by:  Folder =
B Desktop Includes: 2 locations S
= Libraries .
s Choose a location Date madified Type -
@ Music Type file name 7/30/20135:02PM  File folder
[=] Pictures 7/14/2009 8:08 AM File folder E
B Videos To choose 7/30/2013 5:02 PM  File folder
) Homegroup another format 7/14/2009 8:08 AM  File folder
A Abed Allh e.g. PDF 7/30/20135:02PM  File folder
E.?" Cumputer i —_--_-_-_-.-:.f.-e_-:_-r.-e_-_-_-j s }
File name: Word2010, pdf -
Save a5 type: | PDF (*.pdf) -
Authors: Islah Gharaibeh Tags: Add atag
@ When done click Save Button —}[ e ] | Gancel ]
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B. Open a new document and start typing

Create a New Document

1. Click the File tab.

2. Click New.

3. Double-click Blank document.

Create a New Document with a Template

Templates can help you create a more professional document.

1. Click the File tab.
2. Click New.
3. Under Available Templates, do one of the following:

— Click Sample Templates to select a template that is available on your computer.
— Or Click one of the links under Office.com (you must be connected to the Internet), then double-click the

template that you want.

32

Home Insert Page Layout References Mailings Review View
‘ H Save
ailable Templates
Save As %aa \a\-“ )
o ome
ﬁ Open C-“:a'@tz .cpiﬁ‘
J . kY =3 e
1| [ Cos e.aﬁ‘?“o‘( v . ™ . N e |
u“b \ﬁﬁ\ | o~ I/ ) |
o =) LY ||
| L -,__..-/? L= =  — | —
Recent Blank Blog post Recent Sample My templates  New from
document termplates termplates existing
Mew Office.com Templates [Search Office.com for templates || »
j L _J J TTTT]‘]‘]‘E]‘
Save & Send | | L | — | _H e L
& ) & - L & & I
Agendas FAward Brochures Budgets Business Calendars
Help certificates cards
[z] Options ._'| O Y Y 5 =~
R . <p |_ - l! il
== " || == _ ,,m,l i
Contracts Diagrams Envelopes Expense Faxes Flyers
| reports
Mlcrosnf.t‘L_.J-
Office
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C. Printing

In previous versions of Word, there was a Print Preview option in Word 2010 is combined with the Print
window to create the Print pane, which is located in Backstage view.

o

Or use Quick Print = in the Quick Access Toolbar.

(@ 4 - 0 o 017 testWord2010.docx - Microsoft Word | L) ")
n Home Insert Page Layout References Mailings Review 9 4
|
i save e The Print button starts printing
n (&~ %
L} save As J-?d » Number of copies
i ] Copies 1 -
- Open Print T
3 Close | — ) [m|
P Printer type
Print j
Info nnier -
, ) Samsung Universal . o (o v
Recent mmdy . ‘f'
[ P
{ New nnter Propentics ~|32a3 | It you only want to print certain
‘ Settings = L ET | > pages, you can type a range of
_ 4 Prnt All Pages . ;-57___"__:..___‘ 1 pages. Otherwise, select Print All
St & Send ] Pnnt the entire decument ?: e Paaqes.
Pages: ol &5 3 : 2
Print one side or both sides.
it | Print One Sided . TR |
) Tostions =] Only peint on one side of th.., m—— = If you are printing multiple copies
' o Collated = ] of a multi-page document.
&3 et GR, % 1 < =
= ——s—p Choose horizontal or vertical
|a) PoraitOrentation X mmmmeen || orientation of pages.
[T7] Letter
gaonies — P Choose paper size
|
Dlarrow Morgeng . -p Adjusting the margins
d Left: 0.5°  Right: 0.5 J g g
1 Page Per Sheet - - Number of pages per sheet
PageSetup 4 4 of33 » I3

1.3. The Ribbon

The tabbed Ribbon system was introduced to replace traditional menus. The Ribbon contains multiple tabs
(Home, Insert, Page Layout, References, Mailings, Review and View), each with several groups of commands
Some groups have an arrow in the bottom-right corner that you can click to see even more commands.

Now let’s start exploring the facilities provided by the ribbon tabs and their groups in the
following sections.

Mlcrosof.t‘ L; J
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2. Home Tab

Provide commands for basic formatting your document, such as the font (type, size, color... etc.), text
alignment, and creating bulleted or numbered lists and others. It includes the groups: Clipboard, Font,
Paragraph, Styles and Editing.

2.1. Clipboard Group
To paste the text that has 3{, Cut _}To move/ removea text
been cut / copied \ .
53 Copy |—p Tocopy a text
Paste

- 3 Format Painter To copy a format from specific
text and apply it to other text

Clipboard [

You can also cut, copy, and paste by right-click then choose the desired action from the popup menu.

2.2. Font Group

® 9, ®

Fonttype Fontsize Grow [ Shrink font

® & e A / Change Case
Bold 1 I — Sentence case,

Times NewRom ~ 12 ~| A" A7|| Aa~ | &%
®) rtalic

lowercase
®Underline§~. B 7 EI v Iﬁ'E X X|| A2~ A UPPERCASE
M“ Font fa Capitalize Each Word
@ Superscript { Subscript 10 12 tOGGLE cASE

Taxt Effects Font Color

Computer skills in Balgaa Electronic Academy | Text Highlight Culor@

Click the small arrow in the bottom-right corner of the Font group. The Font dialog box will appear (Look back
to Appendix2).

2.3. Paragraph Group

Computer Skills '*
. . Multilevel List
» First Exam Bullets and A Increase / Decrease Indent @

¥ Imtroduction

< Windows Numbﬂring = . = el s= 5= =T A
P Second exam @ .- = i= iE A 1 —t-s—sl—} Text @
e | = . F ~ Direction
¢ Excel !!i il | iE ‘@ B
#  Final Exom B
+ Firsi+ Second J l. Paragraph & @
; m:-:;zum: @TEH Alignment ® Justify  Line and Paragraph Spacing
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Text Alignments:

Left: Aligns all the selected text to the left margin.

Center: Aligns text an equal distance from the left and right margins.

Right: Aligns all the selected text to the right margin.

Justify: Justified text is equal on both sides and lines up equally to the right and left.

To Change the Level of a Line in a multilevel list:

Press the Tab key to increase the level, or hold Shift and press Tab to decrease the level. OR click the
Increase Indent command to increase the level by 1/2 inch, or click Decrease Indent command to decrease
the level by 1/2 inch.

Click the small arrow in the bottom-right corner of the Paragraph group. The Paragraph dialog box will
appear (Look back to Appendix2).

2.4. Styles Group

.ﬂ.aBchDE AaBbC( AaBbCc AaBhCd aaBbced AAD (. Ay

T Mormal |TMoSpac.. Headingl Heading2 Heading4  Heading5s Title = EFFEI‘”EIE
as -
Styles P

Style Sets include a combination of title, heading, and paragraph styles. Style sets allow you to format all the
elements of your document at once, rather than formatting your title and headings separately.
Click the Change Styles command, then select Style Setfrom the drop-down menu.

ADWORKS, INC. ADWORKS, INC.

SaLEs Team MONTHLY REPORT

SALES TEAM MONTHLY REPORT

January 2010 JANUARY 2010
EXECUTIVE SUMMARY EXECUTIVE SUMMARY
January 2010 has been a profitable month and the company has shown growth in many 7
arenas. Ad sales are up by 23% and capital expenditures have decreased since 4% :r::::;ﬁmmm&.mﬁxyﬂj:mms ad
quarterin the Sales Department. The sales team hired a new design specialist, the role Department. The sales team hired a new design specialist, the role of VP of sales was filled, anew
Elegant Style Set Formal Style Set

2.4. Editing Group

34 Find ~ =P Find: Searches the document for a specific word or phrase

2. Replace =) Replace: Change a word or phrase
Ly Select ~
Editing

Ca
Mlcrosnf.t' J_: J
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(1) Find Text:

o O e
word _p(»D Type what you want to find here
1 of 24 matches
- — Click to step through
] E"_" ’ @| the results

r

L. Introduction to Word 2010 Environment

1. Introduction to Word

Word 2010 is a word processor that allows
you to create various types of documents

such as letters, - =
- Word 2010 is a word pro«
Ward 2010 is a word processor that allows ﬂ}?m, faxes and more.
you to create various types of documents “‘\.
such as letters, L . . .
_ T@ Click a result to jump to it
(2) Replace Text:
[ Find and Replace m
| Find | Replace | GoTo |
Find what: |word200? IEI
Replace with: |word?_0 10] IEI
Mare == ] [ Replace ] ’ Replace All l I Find Mext ] [ Cancel ]

3. Insert Tab
Provide options to place visual enhancements in your document, such as pictures, tables, and charts. We’ll focus
on the following groups: Pages, Tables, Illustrations, Header & Footer, Text, and Symbols.

3.1. Pages Group

e @ Choose one of the predesigned cover pages; the cover page is
D D =l inserted by default at the beginning of a document
s =

Cover Blank Page 4—@ Insert a Page Break and move to the next page

Page~ Page Break

Page Insert a New Page and move to the next page
3.2. Tables Grou q —)
P .;1 @ HERR Mln:wetll:emou;etof
. . . select the number o
A table is a grid of cells arranged in rows and . EJJDJD% columns and rows
columns. Tables

The table appears in the document

@

Place the insertion peint to add text

University College Department @

Balgaa IT SE
Mlcrosnf.t' d;J
Office
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When you insert (or select) a table, Design and Layout tabs appear under Table Tools on the ribbon. Using
commands on the Layout tab, you can make a variety of modifications to the table.

To Apply a Table Style:
= _——— e
'}:i:!:!:l: ===== ::::('DE
Table Styles OR click the arrow to
Selectthe desired style see other table styles
University College Department
Balgaa IT SE

Exercise: by using Draw Borders group in the Design Tab, do the following:
1. Add a blue, 1pt weight inside borders to the previous table.
2. Add ared, 2pt weight outside borders to the previous table.

To Convert Existing Text to a Table:
Select the text you wish to convert, then click the Table command, choose Convert Text to Table from the
menu. A dialog box will appear. /Choose one of the options in the Separate text at: section. This is how Word
knows what text to put in each column.

Convert Text to Table m

Table size

Number of columns: 3 =)

Number of rows: 5 =
Name Year Hobby AutoFit behavior 3 Name Year [ Hobby
Lama 2003 Reading @©) Fixed column width:  |Auto 2 Lama 2003 Reading |
Tameem 2007 Football @) AutoFit to contents 1,\;1ar_neem gg% goottgall
Mais 2010 Drawin , ais rawing |
Mohamad 2012 %nnes SR to Yendow Mohamad 2012 Tinnes

Exercise:

1. Insert a 3X2 table

2. Insert two of your friends names and their addresses.

Now by usmg right click menu options:

3. Add a 3 columnthen put your friends ’university names on it.

4. Add a new row between the 2" and 3" rows to add a new friend’s information on it.
5. Delete the address column.

6. Delete one of the rows.

37 2010



Chapter 3 Microsoft Word 2010

3.3. llustrations Group

®@®®

Insert a picture s Takes a Screenshot from
from file il [JL] @ — (4 the document as a picture
Pict Clip [|Sh SmartArt Screenshot
s | P it st Insert a Chart (Bar, Pie,

Line... etc.)

Insert a Clip Art ¢—— / IllustramN

Insert a simple Shape (arrow, rectangle, Insert a complex shape (process diagram,

square, star, banner, callout... etc.) Venn diagram, organization chart... etc.)

When you insert Clip Art or a picture from a file, you may notice that it's difficult to move it
exactly where you want. That's because the text wrapping for that image is set to In Line with

Text. You'll need to change the text wrapping, from the Wrap Text command in the Arrange | wrap
group in the Format tab. e
Inserting Clip Art: Clip At =%
Search for:

1. Click the Clip Art Button books | [Cso ]
2. Enter keywords in the Search for: field that is related to the image you | Resuts shouid be:
wish to insert. alneits s -]
3. Click the drop-down arrow in the Results should be: field. i;‘i‘;",fy?fﬁgfﬁ:hiﬁm
4. Deselect any types of media you do not wish

&

3.4. Drawing Tools Format

When you insert a shape (wordart, clipart or a picture), a new Format tab appears with Drawing
format the shape (color, outline, shadow, 3D ... etc) or change to a Different Shape.

Tools. You can

Wd9-0o&R= New_Skills Word 2010.docx = Microsoft Wo [e=ae X
File Home Insert Page Layout References Mailings Review  View Format o 0
\\OOO - {XEditshape~ O shapeFill ~ AtextFil v ||} Text Direction * . . @ Bring Forward ¥ |§. Align 5oz
AL, G| E DrawTed Box Abc Abc +| [ shape Outline A A «| ¥ Text Outline | [] Align Text » [ Send Backward + 18] Group
% .\f\{ } e = Posmon Wrap s 51079
2 J Shape Effects * | [2\ TextEffects v | & Create Link Text~ %{} Selection Pane 5 Rotate ¥
Insert Shapes Shape Styles WordArt Styles | Text | Arrange Size M |
Mlcrosof.t‘ | =) J
Office
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N\ OO O -|{XEditshape - —pTo change

A—I-—LED& (5 ~ (2] Draw Text Box the
VAN selected
Insert Shapes | shape

'+ | &1 shapeFill ~ Allows you to apply a preset fill and outline,
. . ﬂ « | shape Outline ~ pto a Shape and other effects such as Preset,

% |2 Shape Effects ~ Shadow, Reflection, 3-D Rotations ... etc.
Shape Styles |

Click the small arrow in the bottom-right corner of the Shape Styles. The Format Shape dialog box will
appear.

The same thing maybe done for the Styles group of a WordAurt, ClipArt or a Picture, (Look back to Appendix2).

A, TextFill » Allows you to apply a preset fill and outline, to
‘ A A @Te’“ Outline ~ | L a WordArt and other effects such as Preset,
¥ | [\ Text Effects ~ Shadow, Reflection, 3-D Rotations ... etc.
WordArt Styles [ ;

[||2 Text Direction ~ =P Change the orientation of the text or rotate the text
[[Z]alignText - == Align the textin the text box
& Create Link

| Text

@ Position the selected —) [h Bring Forward = |2 align =
object in the page, text is '

Eﬁ Send Backward - E Group
H Position Wra
“umm““t:;"z EE:‘:’ wrap - Textp“ Hiy Selection Pane Sl Rotate =
around the objact *

Arrange
Change the way text wraps around the selected object

3 o039 4= Adjustthe Height and Width of the object

&

a4k

— .
i< 061

LR

Size ]

Cla

Microsoft L_, J
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3.5. Header & Footer Group

Header Footer

-

= [,
=

Page
4 MNumber =

Header & Footer

Headers and footers can help keep longer documents organized and make them easier to read. Text entered in
the header or footer will appear on each page of the document.
Click Header (or Footer) then select Blank the drop-down menu to insert a blank header (or footer), or choose

one of the built-in options.

[+ Title |

Chapter 3

Microsoft Word

| Header |

The Design tab will appear on the Ribbon, when you're finished, click Close Header and Footer in the Design
tab, or hit the Esc key. After you close the header or footer, it will still be visible, but it will be locked. To edit
it again, just double-click anywhere on the header or footer, and it will become unlocked.

| Header & Footer Tools
Design ‘
j j ’] 3 = g I, Previous | Defterent Furst Page 5 Header trom Top:  0.5° .
: 2 - = 2l Rk o = -
= - ) = =5 au 3, rext ] Ddferent Odd & Even Pages [ Footer from Bottom: 0.5° e
Header Fooler Page Date Quick Picture Clip Goto . Close Meader
- Number~ & Time Parts~ Art er Footer = tof ol Show Document Teat 1) tnsert Alignment Tab and Footer
Header & Footer Intent Navigation Options Pasition Chote
3.6. Text Group
Select a text then click

Select one of the
built-in text boxes or
click and drag to

draw the text box

4

A= & signature Line =

here to choose one of
the WordArt options

. Computer SKILLS

(53 Date & Time
Text | Quick | WordArt ) Drop )
Box~ |Parts - - Cap -~ '@ Object ~
1 (o) Text
i

Mlcrosof.t‘ [ J
Office
2010
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3.7. Symbols Group

Built-In =
Area of Ciecle ’l
A=nrt
u Equation Symbaol
e @ Select a symbol from
m symbaols .
{x+ajn-2[“]x*aﬂ-k the symbol dialog box
k
e Sy (-2 fom|

Expansion of a Sum

(1+x}l“=1+¥+n{";|ljx=+m Eo: | [pormal et [] sutmer Currency Symbeis =]

L —— ' |,@¢EF£mHP:sRszﬂI{T'
J | o T™

= - — Dol 8| PG &l2|CT Ga| £ | Ne Qe |4

f(r}=au+2(anmsT+bnsinTj a V| %) e 3| Wl o =] T|—| | | 111 a

: Az -/ [V]e[L[n]T][=]2]=]<]2 .

Becently used symbob:
e —— (el <]¥[e[o[™[[<[>[+[*[<[u[a]s]

| =
@ Select one of the built-in P o [menren, | ::‘TZ,::,{ trom: urscode forx)[7]
equations or click the insert a L ! _ |
new equation option Carc

4. Page Layout Tab
Provides options for more advanced formatting of your document, such as themes, margins, page orientation
and size, including the groups: Themes, Page Setup and Page Background.

4.1. Themes G To Ch B colos Y 6 stomizi
1. emes roup o] ange ustomizZing
*—. F -
. [O]effects ~
Themes

Suppose you really like the fonts from one theme, but you'd like to experiment with different color schemes,
you can mix and match the colors, fonts, and effects from different themes to create a unique look for your
document.

4.2. Page Setup Group

| Toformat page —  — -
|O" el B O E e
i ~|=g 1 Ll £5) Line Numbers -
| = Margins Orientation 5Size Columns
AT : To change Page i S - » & ion -
: %. g_ _9 .Q | b~ Hyphenation
i = ~~H | Orientation Page Setup F]
@To choose paper Size To add columns
. to a document
i Landscape: horizental page
i Bottom -
_—_— Portrait: vertical page
Mlcrosnf.t'd—'J-
Office
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lrlé" Breaks ~

0 ks A watemark ™ Indent - seadn | nca you've created columns, the text will automatically
: #2 Line Numbers ~ @Page(olor' = Left: 0 - || y= Before: R
Size |Columns| o phenation = | [ Page Borcers | Exmight: @ 3 ¥=amex | TIOW from one column to the next. Sometimes,
one | Page Background Paragraph though,you might want to control exactly where each
'Er{ 4 Frrr | COlumn begins. You can do this by creating column
T breaks.
N Near
w Thice ince that the 2010 Cityville High teacher of the yed
:w mathteacherforl6yearsandhasbeenwdi1€1ty1
tin Lenseded.:cahmtohetsmdenisandﬂteschool.sh
; Left 1gthecorporatespellmgbeeandMathematchu
c gainst Cityville High students in two fundraising|
: Right rent head for the last three years. Thank yot1 to Ms
c ward wellearned!
l £ More Columns...
C ents Win Award
Susan Thompson and John Smith, two Cityville sophomores, have won th
{a Better place award. The two 10th graders organized a recycling project tt
Teacher of the Year PTA Bake Sale

We are pleased to announce that the 2010
Cityville High teacher of the year is Ms. Mary
Jenkins. Ms. Jenkins has worked as ahigh school
math teacher for 16 years and has been with

The Parent Teacher Associationis holding its
annual bake sale on Saturday, February 16th
from10a.m to4 p.m. at the Cityville Town
Festival If you're interested in participating, we

[A] Watermark ~  Indent

i Size  Columns

- -

Page Setup

Page Breaks

Cityville High for 12 years. In that time she has
shown 1 dedication to her students and
the school. She is single-handedly responsible for
organizing the corporate spelling bee and

still need people to work various shifts
throughout the day and are always looking for
more donations of baked goods. To ensure the
freshness of all foods we sell, we're asking that
Mathematics Quiz Bowl, which challenges local all donations be delivered on Friday, February
comparies to mmplete -gnmst Cityville Hx;h 15thfrom8 a.m. to3 p.m. inRoom 555. Contact
d in two events. Add Ms. Drake at 555-555-5355 with any ques tions.

Page
Mark the peint at which one page ends
and the next page begins.

1

she served as Math Deputmgnt head for the lAst

Column I

Indicate that the text following the column
l}hreak will begin in the next column.

three years. Thank you to Ms. Jenkins for her
dedication and congratulations for an award well
eamed!

Cityville Students Win Award

Valentine’s Day Fundraiser
The rose sale is well underway, but the PTA has
not yet reached its fundraising soal of §5,000.
Please continue to sell the roses and try to help
the PTA reach their goal Remind potential

Insertion point

n break and start the new

collection program of the recycled items that will
not defer any of the costs to the school system.

T TEXCWIap PG Susan Thompson and John Smith, two Cityville buyers that 525 a dozenis an excellent rate for

e — A sophomores, have won the Town County Make roses this time of yvear and that delivery is only

[m=| Separatetextaround objects on web the Wozld a Better place award. The two 10th $5. All profits go to support the Cityville High

— pages, such as caption text from body text. graders organized a recycling project that affects PTA in its efforts to fund school programs such
t.he entive sd\onl svstem All schools and as the drama club, envirormental club, athletics,

. 1gs are now equipped with and more.
Section Breaks recycling containers that the students

distributed. Inaddition, they arranged for a free Tuioring Available

The tutoring center has availability for students
that need help in any subject. The center is open

The students were recognized in a January
ceremony, presented with a plaque, and
awarded 51,000 each.

e next page, during lunch break, and after school from 3 p.m.

t04:30 p.m. All tutoring is free of charge.

To Open the Page Setup Dialog Box:
Click the small arrow in the bottom-right corner of the Page Setup group (Look back to Appendix2).

4.3. Page Background Group

. s s A

‘Welcome 1o skills 1

O—3 B O

Insert ghosted text Watermark Page _Page Addf Change |}  um E
behind the content Color~ Borders | page borders ¢ 0" i
of the page Page Background A Monamas 3

E Good Luck E

Choose page background color

FerrrrEREEEERTERTE

Cla
Microsoft La -J
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5. References Tab

Provide options for using various citations in your document, such as footnotes, bibliographies, and captions,
we’ll focus on Table of Contents and Footnotes groups only.

5.1. Table of contents Group

[Zp Add Text ~
=" update Table

A table of content helps in navigating a word document by providing associated
page numbers and direct links to various headings available on those pages. You able of
can insert a table of content anywhere in the document, but the best place is always contents -
at the beginning of the document. Table of Contents
e Put the insertion point at the beginning of the document and then click the References tab and next Table
of Content button which will display a list of Table of Contents options.
e Select any of the displayed options by simply clicking on it. A table of content will be inserted at the
selected location.

5.2. Footnote Group

@ Amma niiS agreatc It"pfl ABi L) Insert Endnote
. b .
A number will @Click after the word Insert Aﬁ_"m Footnote
appear at the Footnote | =/ Sho
end of the page i Capital of lordan Footnotes

What is the difference between a footnote and an endnote?
Footnote appears on the same page as the reference and endnote appears at the end of the document. Both can
be flagged with a superscripted number or letter.

6. Review Tab

Provide options for editing your document’s content, such as a Spelling and Grammar check notice the Proofing
group.

Turuna_’ ? @ DJ Iﬁ

5PE”ing & Spelling &4 R h Th Ward

pelling esearc esaurus an

G::;;mmkar Grammar Count
18¢ Proofing
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A
@(_Spelling E||0|J

Speling and Gramenae English (U5} [ B i Spellng and Gramesar Enghsh (U5) [0 e |
Sulypernt Wil Agreament) Port: i Dc iy
Ali go to skool everyday =~ Ali go to skool everyday
| leeRie | Bgrere M
_| [ memtsensmnce | _ | [ 1o pxcoonary |
Suggesions: i Sugestor:
—————— str=d -
[ o Tange
SOO00 Ay inCayer
(actorury lrgusge: | Egish (1.5) [ Eichonary languape: | Enghsh (1.5.] =]
o Cheserl F e of | Chnck; grame
[ gpsone... | [ unds | | Cooe | w{iuﬂs e

Another way is: right-click the underlined word. A menu will

appear then click on the correct spelling of the word from the Ali go to SkOO”
listed suggestions.

school

stool

spool

solo

scoop

Ignore

Ignore All

Add to Dictionary

7. View Tab

Provide options for examining your document, such as a full screen view, print previewing, and zooming in or
out, notice the groups; Document Views, Show and Zoom.

Ql M =| [= Ruler ) one Page
| b == ==
[ Gridlines [2 Two Pages
Print [Full 3creen Web  Qutline  Draft o Zoom  100% i
Layout| Reading Layout [C] Mavigation Pane =] Page Width
Document Views | Show | Zoom |

8. Auto correction options

The AutoCorrect feature automatically corrects common typographical errors as you type the words in your
documents. Following are the steps to correct the word “ail” to “Ali”” automatically:

Cla

Microsoft L._ J
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o =
H Save General Change how Werd carrects and formats =
our text.
Bl save As L ’
Froofing || AutoComed oplions
[LF Open 1T Seve Change huw'ﬁ'u:d@ [ — |
4 corrects and forma Autclarrect Options...
[ Close Language 34 i By K
il'lfﬂ Advanged When conrecling speifing in Microsolt Office programs
Cisttamize Ribban ] Tanare waedd in UPPERCASE
Recent Qulck Agess Toalbar [#] Ignaore woeds that cortain numigers | i
Ignare Internet and file addieiies
MNew Asd-Ins [#] Flag pepeated words
pin O = e
ve n Custom Dictionaries...

Save & Send
HEI French modes: [Trad'rllnnalandnmutlnng:El

p Spanish modes: |'I|.|'bmﬂ!l:l'|'-urms only l:l
+] Options =
3 [ e || camea |

Exit —-

AutaCorrect: English (U5}

S

Actions

|
bl MusteCorrest il. Math futeComect |

AuloFcemal As Vou TYpe

[] Show AutaCorrect Cpbions buttons

[ Correct TWo htial CApitals

[7] Capitative fiest bebter of gentences
[¥] Capitalize first batter of table gelis
[#] Capitatize names of days

ol texk

Correct accidental usaos of CAPS LOCK key

Formatied fext

Exceplicns. ..

[] Austomabcally use sugoestions from the spel

45
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Appendix 1
Keyboard Shortcuts

Word 2010 offers a number of helpful keyboard shortcuts for performing tasks quickly. Here are some shortcuts
for common Word formatting, editing, and file and document tasks.

Command Shortcut
New Ctrl+N
Open Ctrl+O
Save Ctrl+S

Save As F12
Print Ctrl+P
Help F1

Page Break Ctrl+Enter
Bold Ctrl+B
Italic Ctrl+l
Underline Ctrl+U
Center Ctrl+E
Left Align Ctrl+L

Right Align Ctrl+R

Justify Ctrl+J

Clear Formatting Ctrl+spacebar
Undo Ctrl+Z

Repeat Ctrl+Y
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+Vv

Select All Ctrl+A

Find Ctrl+F

Replace Ctrl+H
Spelling and grammar F7
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Effects
| [C] strikethrough [ small caps
[ Double strikethrough 1 all caps
[C] Superscript [ Hidden
[ subsaript
Preview
Sample Fapa N

Appendix 2

Important Dialog Boxes

Font P | S

Font Advanced

Latin text
Font: Font style: Size:
|Aria| |z| Regular 10.5
~| |8 -
Italic 9
Bold hll k] T
Complex scipts
Font: Font style: Sige:
|Ar:|a] |z| |Regu\ar |z| 10.5 : |
Al text
Font color: Underline style: Underline calor:

| ] :l {none) : Automatic :l

This iz & TrueType font. This font will be used on both printer and sareen.

Set As Default | [ Text Effects... | [ ox ][ cancel

Font

Page Setup

Margins | Paper ILaynut |

] [ E

Margins
Top: 0.57 EI Bottomn: 0.57
Left: 0.5" B Right: 0.5"
Gutter: " E’ Gutter posiion:  |Left
Orientation

Portrait Landscape

Normal ﬂ

Pages

Multiple pages:

Preview

Apply to: | Whole document ﬂ
Set As Default

—

Page Setup

47

y
Paragraph @Iéj
Indents and Spadng | Line and Page Brezks
General

Alignment: Left

Outline level: |Body Text

[][]

Direction: () Right-todeft @ Left-to-right
Indentation
Before text: |07 &I Spedal: By:
\ After text: |D' lﬁ" |(none} |Z| | Eﬂ
[ Mirror indents
Spading
Before: Line spadng: At:

After: opt 5 Single : | =

[[] Don't add space between paragraphs of the same style

Preview

Samzle Tt Samels To Saemgls ot Samels Tof Samzl To Samels Tod Tamels Tot Semls

Tabs... ] [ Set As Default ] [ oK } [ Cancel
Paragraph
Format Shape
[ ]| Fin
Line Colar @ Mo fill
Line Style Solid il
Shadow
Reflection

Glow and Soft Edges
3-D Format

3D Rotation

Picture Corrections
Picture Color

Artistic Effects

Crop

Text Box

Alt Text

Format Shape

Microsoft .
Office
2010
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Learning Objectives:
After completion of this chapter, you should be able to:

Describe Excel 2010 Environment, such as: tabs, groups,, book and sheets ... etc
Identify the meaning of row, column, cell and cell range.

Format the data using the formatting groups in the Home Tab

Know how to insert, format and edit Charts.

Know how to insert, format and edit Heeder & Footer.

Create Simple Formulas using cell references.

Work with Basic Functions available in Excel.

Identify functions available in the Function Library Group.

. Sort data (ascending or descending) and use the Custom Sort for multiple levels sorting.
10 Filter Data using the Filter command.

11. Convert a given Text in a cell to Columns.

12. Add a Comment to a cell.

13. Use Templates in opening new Excel sheet.

14.Recognize the available options in the dialog box (Format Cells).

©oo Nk wdE

I",.

Microsoft —-J

Offlce

2010



Chapter 4 Microsoft Excel 2010

1. Introduction to Excel 2010 Environment

Quick Access Toolbar File name.xlsx Minimize — Maximize - Close

= O L Crosoft Exc = X

49+

File Home Insert Page Layout Formulas bm Review View as I~y ? or X
=N ¥ Calbn e - W g B Generdt = A gelnset~ X - 97 Lﬁ
' ;%q' BZ U- AA EFEF N $ % » Shes 4% Delete ~ 3'5"“&;6&
aste ol e . O n
e ¥ |B- 19 A- EE D - BH - [E)format~ 2~ Fiter~ Select~
Chipboard 7. Font . Alignment » Number . Cells Edting
> ‘ o
D | E \F G H I \;\\ K
1
2 Formula Bar Groups
3 5
- Column Letters
5 | >
6
7 Active Cell
8
9
10 Worksheets (3 sheets by default) ) Zoom Button
oL Views ~ Zoom Slider ~
M 4 » W Sheetl ~Sheet2 ‘Sheet3]| 3 M4l 4+ : >
| Resoy | — B Status Bar (a8 3 & f100% & oW
Right-click the worksheet:
Insert,, =P (1) Adda new worksheet
Ui Delete =P () Delete the worksheet
Bename  wmmm——}p (3) Rename the worksheet
Move Of COPY... mmmlp o Move or Copy Worksheet
Q4 View Code
&)y Protect Sheet...
Tab Color '—b@ Color worksheet tabs to help organize your worksheets
Hide

Select All Sheets
Sheet 1 sneewromees— ¢

1.1. Definitions
Each rectangle in a worksheet is called a cell. A cell is the intersection of a row and a column.
Each cell has a name, or a cell reference based on which column and row it intersects. The cell reference of a
selected cell appears in the Name box. Here you can see that D5 is selected.
You can also select multiple cells at the same time. A group of cells is known as a cell range. Cell range is
referred using the cell addresses of the first and last cells in the cell range.

Cla
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1.2. Range Types

(1) Vertical Range : e.g. B2:B9

(2) Horizontal Range : e.g. E2:J2

F G

(3) Block Range : e.g. D4:F7

I J Kk |

"~

A B c D E

1.

2| |
3.

4

5

6

?.

8

9 ‘\@

10

16l

e

Enter contents into the selected cell using your keyboard. The contents appear in the cell and in the formula
bar. You also can enter or edit cell content from the formula bar (or double click on the cell).

Exercisel: Select a cell then enter:
Ctrl + ; > what’s the contents of the cell?
Ctrl+ : = what’s the contents of the cell?

1.3. Using the Fill Handle to Fill Cells

Enter 1 in a cell then enter 2 in the 1
cell below, select the two cells as 2
seen in (1). Position your mouse over
the fill handle so that the white cross
wrbecomes a black cross+. Click
and drag the fill handle until all the
cells you want to fill are highlighted
as seen in (2). (you can fill vertically
or Horizontally)

Exercise2:
Try to find out the result of filling

cellsin (3), (4) and (5). @
2. Home Tab

2.1. Clipboard Group

10

1 January Sunday

W 00N UL H WN =

v v v

® @ ®

Wi

= 4 Cut

As you’ve studied in Word, Copy, Cut and Past commands are also used in J 23 Copy -

Excel. Notice that when selecting the cellsmthen clicking the Copy or -
cut command, the border of the selected cells will change appearance

50

Paste
# Format Painter

Clipboard

Cla
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then select the cell or cells where you want to paste the content, and then click the
Paste command. The copied content will be entered into the highlighted cells.

To Access More Paste Options
There are more Paste options that you can access from the drop-down menu on the

Paste command

2.2. Font Group

To change
Times New Roman ~ 12~ A" /
@ font color
B 7 U~ | iiiv
To add a _~—}‘ To add a fill
border Font \ color

2.3. Alignment Group

i] * Calibri

| Paste ¥ B 71

Pt \
j Fe e 5 |
r‘—T .'j

Paste Values

123 I.’Q“, l%

Other Paste Options

%y (=2 & &

Paste Special...

Align text

=) Wrap Text

@ 1 |A[Ba|qaa !Applled Unlversm/

to the
Top / =i Merge & Center |
Middle /
Bottom @ - Before
of the A
cell AlBalgaa A B [ ¢ D
Applied 1 | AlBalgaa Applied University
1 |University 2
2 After
2.4. Number Group [ Format Cells -2
To format numbers and dates in General ’
the cell. $ - % o 8% Category: B
General ]
You can have the Format Cells Number D- 5_:"’:"
. . . unaa
dialog box also when right click on Qureney . I:o . .
a cell or multiple cells and choose Date o o S TR neseae
Format Cells option from the Percentage
Fracti
popup menu. Fracton
Text.
Exercise3: Look back to the it
chapter appendix and find out the N
other tabs contents (2, 3, 4, 5 and
6). ok || cancel |
Cla
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2.5. Styles Group

Once you have entered information into a spreadsheet, you may want to format it. Formatting your spreadsheet
can not only improve the look and feel, but also make it easier to use.

You will learn how to format as a table, to take advantage of the tools and predefined table styles available in
Excel 2010.

When you click the Format as Table command in the Styles group a list of predefined table styles will appear.
Click a table style to select it (the below figure as an example).

Name Mark _;d' Format As Table )
Qasem 76 Format Hher 2 e o your o0l? Qasem 76
Ahmad 84 e = » Ahmad 84
I | | == s == &) [ ) Sami__| 35
Zaid 90 == - oo CC TTOCE Zaid 90
Fares 40 e oo || oo Fares 40
Nader 76 == e E==== Nader 76

Once you choose a table style, a set of Table Tools, arranged into five tabs, will appear on the Ribbon. You can
use these tabs to modify your table style

Table Tools
Design
Table Name: [i3] summarize with PivotTable ? > [ Properties Header Row  [C]] First Calumn
Tablel :}“ Remove Duplicates Ope Browse |:| Total Row |:| Last Calumn
= Export Refresh
:] Resize Table | 47 Convert to Range - - =2 Unlin Banded Rows D Banded Columns
Properties Tools External Table Data Table Style Options Table Styles

2.6. Cells Group

@ Tm E (] @

To insert To delete
cells, rows 7 Insert Delete Format | co|lg rows
or columns or columns

Cells

To Insert Rows: Select the row below where you want the new row to appear, and then click (1).

To Insert Columns: Select the column to the right of where you want the new column to appear, and then
click (2).

To Delete Rows: Select the rows you want to delete, then click (2).

To Delete Columns: Select the columns you want to delete, then click (2).

To Modify Column Width:
Position your mouse over the column line in the column heading so that the white cross <*hecomes a double
arrow * .Click and drag the column to the right to increase the column width or to the left to decrease the
column width [Follow the same steps to modify Row Height]

Cla
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To Set Column Width (or Row Height) with a Specific Measurement:
Select AutoFit Column Width (or Row Height)from the format drop-

down menu and Excel will automatically adjust each selected row so that

all the text will fit.

3. Insert tab

Insert Delete

=" E( iil Z AutoSum ¥ W
= & Fill ~ =
Format

Sart &
<2 Clear - Filter -

Cells_ | cell Size
' Row Height...
[+] AutoFit Row Height
=3 Column Width...
AutoFit Column Width
Default Width...
Visibility
Hide & Unhide »
Organize Sheets
Rename Sheet
Move or Copy Sheet...
Tab Color ¥
Protection
(Ey Protect Sheet...
(21| Lock Cell

ﬁ Format Cells...

As we discussed in Word this tab allows you to insert picture, clipart, shapes ... etc. This section will focus on

Charts and Headers & Footers.

3.1. Charts

Excel workbooks can contain a lot of data, and that data can often be difficult to interpret. For example, where

are the highest and lowest values? Are the numbers increasing or decreasing?

The answers to questions like these can become much clearer when the data is represented as a chart. Excel has
many different types of charts, so you can choose one that most effectively represents the data.

Types of Charts

different types of data, but they're most frequently used for comparing information.

I (1) Column charts: use vertical bars to represent data. They can work with many

(2) Bar charts: work just like Column charts, but they use horizontal bars instead of

‘ vertical bars.

(3) Line charts: are ideal for showing trends. The data points are connected with lines,
making it easy to see whether values are increasing or decreasing over time.

the pie, so it's easy to see which values make up the percentage of a whole.

‘, (4) Pie charts: make it easy to compare proportions. Each value is shown as a slice of

To Create a Chart:
Name Mark
Qasem 76
Ahmad 84
Sami 35
Zaid 90
Fares 40
Nader 76

Column
-

2-D Column

Mark @

[at)] 28]

m

o Mark

Zaid Fares Nader



Chapter 4 Microsoft Excel 2010

(1) Select the cells that you want to chart, including the column titles and the row labels. These cells will be
the source data for the chart.

(2) Select the desired chart category (Column, for example).Select the desired chart type from the drop-down
menu (Clustered Column, for example).

(3) The chart will appear in the worksheet.

Exercise4: Find out the bar, line and pie charts for the same data shown above. Which chart the most clarifies
the data in your opinion?

Chart Tools
Once you insert a chart, a set of Chart Tools, arranged into three tabs, will appear on the Ribbon. These are
only visible when the chart is selected. You can use these three tabs to modify your chart.

"I ol - i =)
Change Save As Switch Sel:d —]J-_J —1Lj- JLL ; ‘ I . I . I . I . [ | ‘ I . ‘ I . : Move

Chag Type Template Row/Column ta > Chart
Type 1 Data | @1 Layouts Chart Styles ’ | Location
~—~

To change To switch To ch Chart | ¢ d Stvl To move the
the chart row and © change art layouts and Styles chart to another
type column data sheet

® @ @

Switch Row and Column Data

100

Sometimes when you create a chart, the data may not be grouped | .,
the way you want it to be. In the clustered column chart above, | =
the student’s marks statistics are grouped by student, with a | -
column for each mark. However, you can also switch the row | .
and column data so that the chart will group the statistics by | ..
mark, with columns for student. In both cases, the chart contains | =¢ -
the same data; it's just organized differently 7

M Qasem
m Ahmad
W sami
W Zaid
W Fares
W Nader

10

Chart layouts and Styles

To avoid a lot of manual formatting, Excel provides a variety of useful predefined quick layouts and styles that
you may want to apply to your chart. You can then customize the chart further by manually changing the layout
and formatting style of its individual chart elements.

3.2. Text Group (Header & Footer)

You can add headers or footers at the top or bottom of a printed worksheet. For example, you might create a
footer that has page numbers, the date and time.

Note: Excel displays the worksheet in Normal view EH by default, after inserting a Header (or Footer) it

moves to Page Layout viewl=l| Cla
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Header & Footer Tools

Once you click Header & Footer command, a set of Header & Footer Tools, arranged into four tabs, will
appear on the Ribbon. These are only visible when the Header or Footer is selected. You can use these tabs to
modify Header or Footer

Header & Footer Tools
Design
8| \ & "] vi
j j ﬂ 7J % tees? - i [t E L Different First Page Scale with Document
Header Footer Page MNumber Current Current File File  Sheet Picture Goto | [T] Different Odd & Even Pages [V] Align with Page Margins
v Number of Pages Date Time Path Name Name Footer
Header & Footer Header & Footer Elements Navigation Options
Al - 5
T ~— T I LI | T | T | T | T T
A B C D E F G H |
- Header
Left section Center section Right section
B 1 . )

—
Header has 3 sections

Exercise5: Insert a header & footer:
In header: write your name in the left, “Computer Skills” in the center and insert time in the right.

In footer: insert a picture in the left, “Good Luck™ in the center and insert page number in the right.
4. Formulas Tab

4.1. Creating Simple Formulas

You let Excel know that you're about to enter a formula in the current cell by entering the equal sign (=). Some
formulas follow the equal sign with a built-in function such as SUM or AVERAGE. Many simple formulas use
a series of values or cell references that contain values separated by one or more of the following mathematical
operators:(+)addition, (-)subtraction, (*)multiplication, (/) division and (*)exponents.

For example, to create a formula in cell C2 that multiplies a value entered in cell A2 by a value in cell B2, enter
the following formula in cell C2=A2*B2.note that if you change a value in A2 orB2, the contents of C2 will
automatically recalculate.

When writing formulas it is easy to make a mistake: listed below are some common error messages:

#HH##HH - The contents of the cell cannot be displayed correctly because the column is too narrow.

#REF! : A cell reference is invalid. This is often displayed when you delete cells that are involved in a formula.
#NAME? : Excel does not recognize text contained within a formula.
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To Edit a Formula: SUM v X v Jfx | =B2+B3+B4+B5
1. Click on the cell you want to edit. 4 A [ B8 | c¢c [ o] €
2. Insert the cursor in the formula bar and edit the Budget
formula as desired. You can also double-click the cell 1 5341 . to
view and edit the formula directly from the cell. ama Edit a formula from
3. When finished, press Enter or select the Enter 3 [Tameem | $210 iy o
. cell. To edit from cell,

command ¥ 4 [Mais $199 double click cell to

5 IMohamad . $122 . view formula

6 Total =B2+B3+B4+B5 &~
Order of_Operatlons (I_Drlorltles): 40/(10-8)*42
1. Operations enclosed in parentheses R
2. Exponential calculations (to the power of) 40/2*4r2
3. Multiplication and division, from left to right. 40/2*%16
4. Addition and subtraction, from left to right. 20*16
Look at the Example beside that shows an example on the order of operations: 320

Exercise6: What is the final answer of 4*3+18/(5+4)-2"3

Absolute References

There may be times when you do not want a cell reference to change when copying or filling cells. You can use
an absolute reference to keep a row and/or column constant in the formula.

An absolute reference is designated in the formula by the addition of a dollar sign ($). It can precede the
column reference, the row reference, or both.

A B C A B | G
1 Budget |After inc. 1 Budget After inc.
2 |Lama $341 =82+82*SBS7»2 Lama $341 | $375.10
- Tameem s - Tameem 5210 [EE $AS$2: The column and the row do notchange
4 [Mais $199 4 [Mais $199 | $218.90 when copied.
Z :(l:zzlamad :;;; Z .I;/:) ct>:|amad 2;.212 2134.20 AS$2: Therowdoesnot change when copied.
W ine Viliie 01 B inc. Value o1 $A2: The columndoes not change when copied.

Exercise7: Type =B2+B2*B7 in C2, then fill to C5, what do you notice?
4.2. Working with Basic Functions

A function is a predefined formula that performs calculations using specific values in a particular order.
Excel basic functions:

SUM > returns the sum of cells in a range.
AVERAGE : returns the average of cells in a range.
MIN - returns the smallest number in a set of values.
Cla
uisasor Gl
Office
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MAX - returns the largest value in a set of values.

ROUND  Rounds a number to a specified number of digits. ROUND(number,num_digits)

IF - returns one value if a condition is TRUE, and another value if that condition is FALSE

IF(logical_test, [value_if _true], [value_if false])

A B ¢
1 Name  Mark
2 Qasem: 76 !
3 Ahmad:! 84
4 Sami 35
5 Zaid 90
6 Fares 40
Nader ; 76
:lTotaI |=sum(B2:87

Adding cells to the function argument

I-Inserlfuncf.il:bn a " M-‘
Search for a function:
- —— Gor
| e -~ X V& L&
=T A S ' = ) = Or select a category: | Logical [z]
1 Name Mark Result (merFunction »m“m’
— AND
2 Qasem 76 | | RALSE
s Ahmad 84 ETM
4 Sami 35 TRUE
IF(logical_testvalue_if_true,value_if_false)
s Zaid 90 m\;x;muuﬁumsmt.mm“vnifmmwmm
s Fares 40
7 Nader 76 denon b drern ; [ ox ][ comel |
[ Function Arguments M‘
Name Mark Result F
Logical_test |525=50 = TRUE
Qasem 76 |Pass « Value if_true | Pass” - Pass”
Ahmad 84 [Pass vehe L fabe [ -
| = "Pass”
Sami 35 Fail Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE.
Zaid 90 Pass Value_if_false :Ii'i'levdl.lelﬂ'latisrerifLoq'cal_t'estisFAlE. If omitted, FALSE
Fares 40 |Fail Formula result = Pass
Nader 76 |Pass L o ) | cnet

A | B |
1 Name  Mark
2 Qasem 76
3 Ahmad 84 FLBET)
4 |Sami 35 Equal Function Argument(s)
5 Zaid 90 Bign.  Name
6 Fares 40

Nader 76

» jTotal E

Result Syntax of a basic function

Exercise8: in D2 write the formula =1F(C2>=80; C2+3; C2+5), fill to cell D7, what is the contents of D5?
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4.3. Function Library Group

Formulas

FIRE R R - RN

Insert AutoSum Recently Financial Logical Text Date& Lookup & Math More
Function v Used ~ v v v Time v Reference ~ & Trig ¥ Functions 5,
{ Function Library Y
D E— You may search and select Excel
Sum
Letyou sea_rch N @ functions based on categories
for your desired | Average
function (or use | count Numbers
the command & | 5
in Formula Bar) |, @ Allows you to automatically return the results for
@ More Busscilons:. a range of cells for common functions

5. Data Tab

5.1. Sorting data

Arranging your data alphabetically, from smallest to largest or other criteria can help you find the information

you're looking for more quickly.

C‘D Ascending Sort 4—f7
@ Descending Sort 4=

@ Custom Sort
(@) Filter Data ¢ 7
A — ] A B
1 [Name Mark ﬂ 1 [Name Mark
2 |Ahmad 84 ‘ 2 |Zaid 90
3 |Fares 40 3 |Sami 35
— Click the —
command to

5 |Qasem 76 carinames B Nader 76
6 |Sami 35 fromZtoA 6 |Fares 40
7 |Zaid 90 7 |Ahmad 84

Exercise9: What name will be inA6 if the sort is ascending?

58
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5.2. Custom Sort (sorting multiple levels)

Allows you to identify which columns to sort by and when, giving you more control over the organization of

your data.
A | B o= o] A | B
1 |Name  Mark st Koot (B2 2) [~ fw--}? 1 |Name  Mark
2 [Qasem 76 || Cokam Sort On Order 2 |Sami 35
zAhmad 84 - - : — : o : zFares 40
e s — cocel e 7
6 |Fares 40 Click the Custom Sort command to s [Ahmad 84
T Nader 76 sort by Mark then by Name ?Zaid 90

Exercisel0: What name will be inA4 if you sort by mark smallest to largest then by name A to Z?

5.3. Filter Data

A

A B

(] (Select All)
1 Name Mark f 1 Name [~ Mar - ™ Os
2 Qasem 76 ‘F“ters 2 Qasem 76 76
-84
3 Ahmad 84 Click th 3 Ahmad 84 Os0
. ic (] .
4 Sami 35 Filter 4 Sami 35 R
s Zaid 90 command 5 Zaid 90 1 Name ~1Mark &
to filter the :
6 Fares 40 data 6 Fares 40 =, Qasem 76
7 Nader 76 7 Nader 76 7 Nader 76
5.4. Text to Columns
Separates simple cell content into | TI &- (= SRS E
different columns based on a delimiter, S== E ;oj ‘I”‘ =
such as a space, tab, comma or Text to REmOVE ‘Dat.a Consolidate What_-lf
semicolon as in the example below Columns JDuplicates Validation ~ Analysis ~

Data Tools

59
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A B C ] ]ComertTmtoColumnsWiznrd-SEeplof3 a (-2 e |
. . ,__:"':__ The Text Wizard has determined that your data is Delmited.
1 Namel Markl Address 1\:—:] If this is correct, choose Next, or choose the data type that best describes your data.
. . extto Original data type
2 Qasemr 76; Amman Columns Choose the file type that best describes your data:
@ {Delmited) - Characters such as commas or tabs ate each field.
3 Ahmad; 84; Zarqaa ‘ s ) Fixed width F:odsareatgnedmmumsmmsp:::bemmmm.
4 Sami; 35; Agaba _ Fréven ofsseced dea:
. Click to e e e <
5 Zaid; 90; Amman separate prose; ot e .
6 Fares; 40; Zargaa tcell . wpeids 20 deman 2
. contents 1o =
7 Nader; 76; Irbid columns o (o> ) [ psn
A B C Convert Teat to Columns Wizard -Step 3 of 3 e | [ et Sep 2013 JER===)
“;::::;“::*“MW“'“*"*WWL |T:mwmnmsmmmm vmmseemmmsaﬂecmn
1 Name Mark Address s
S e e
2 Qasem 76 Amman oo hor  [7] i D] | estconsmasve deers s e
Do not mport column (skip) = E|
3 |Ahmad| 84  7arqaa | i ® Select the delimiter
4 Sami 35 Aqaba S (semicolon)
5 Zaid 90 Amman !"Ei o |
6 Fares 40 Zarqaa - i ; |
7 Nader 76 Irbid [omt ) (b ] L= ] F o) i) (i) ()

6. Review Tab (Adding a Comment)

Name Mark

Qasem 76 ;? - ?:r':lad 84

Ahmad 84 Comment

Sami 35 @ @

Zaid 20 Ahmad 84 :

Fares 40 ® imi 35
Nader 76

1. Select the cell where you want the comment to appear.

2. From the Review tab, click the New Comment command.

3. Type your comment.

4. The red indicator in the upper right corner shows that there is a comment in that cell. Move the mouse over
the cell to view the comment.

You can add a comment also simply by right click on the cell then choose New Comment from the popup
menu.

Microsaft: d_.-J
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7. Using Templates

Excel allows you to create a new workbook using a template, which is a pre-designed spreadsheet, To Create
a New Workbook Using a Template: click New from the File tab, and then click Sample templates to choose a
built-in template, or select an Office.com template category

Available Templates

Office.com Templates

Mileage log with
reimbursement form

“ Home Insert Page Layout Formulas Data Review View
s Save :
Available Templates
Bl saveAs
~ (] Home
5 Open #200° ‘,\a\e &
(ARSIt §
R 9\0 e»c’ “x
g d PAL K\C \ \
S () N |
of xe‘“ < [)\ =
e 2 | Em o
Recent Blank Recent Sample My templates  New from
workbook templates templates existing
Office.com Templates Search Office.com for templatel = il
Print — p— :
A e 4
Save & Send =) : ‘ '
Agendas Books Budgets Calendars Cards
Help
:] Options - > — i )
y e fep—_— / 7
£d Ext V y | Lisl t V /
Charts and Forms Inventories Invoices Letters
diagrams
= —————
Mileage log with reimbursement form
Provided by: Microsoft Corporation
Download size: 10KB
Search Office.com for| | + Rating: 103440437 (1958 Votes)
e Mdrage Loy and Rembulpement Form
i _—
= A | B c D -
1 - |+ Mileage Log and Reimbursement Form
Petty cash request 5
i‘ Employee Name Rate Per Mile
3 4 D For Period From 5/9/02to S
5  vVehicle Description Total Mileage
g Authorized By Total Reimbursement
1 8 Starting Location Destination
j 9 5/9/2002 Home Office Northwind Traders Client Meeting
% 10 5/9/2002 Northwind Traders Home Office Client Meeting
Download };

Travel advance request

* f3 Home » Forms P Business

&

DEPOSIT RECORD

Marm
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8. Ending Work

When you’ve finished your work, certainly you’ll want to have a soft copy (saved in your
computer) or a hard copy (printed) for your workbook.

8.1. Saving a workbook

Click on the File Tab then select:

Save: To save the workbook with the name you want in xIsx format.

Or

Save as: To save the presentation in other format (e.g. pdf) or version (e.g. Excel 97-2003).

8.2. Printing a workbook

Click on the File Tab then select Print from the File Tab to choose from a variety of printing options.
1) Under Print Active Sheets choose,
e Print Active Sheets: to print the sheet that includes the active cell.

e Print Entire Workbook: to print all sheets in the workbook.
e Print Selection: Only print the current selection.

2) Pages.. to: to print a range sheets or specific sheets by number.

3) Under Portrait Orientation, you can choose Portrait for a vertical page or Landscape for a horizontal
page.

Iz“ - |= test - Microsoft Excel = = =
.ﬂn Home Insert Page Layout Formulas Data Review View Q
| Save
Print
Ltg Save As H’;,A
E Copies: 1 -
5 Open
— e Print
Lj Close
Settings -
Info . .
Print Active Sheets -
Only print the active sheets
Recent
Pages: 2 to -
Dlew B[ Coteted .
1,23 123 123
-
j Portrait Orientation -
Save & Send
b - =
Help 21 cmx 297 cm
) Mormal Margins
B e L Left: 178 cm  Right: 1.7..
@ EE jj Mo Scaling -
[199] Print sheets at their actual...
Page Setup [¥ 1 ofl inj [E
1 il »
L o E::I:.j
Microsoft: el 4
Office
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Appendix

Format Cells Dialog Box

r Y i Y
Format Cells lilg Format Cells @lﬂ
Number | Font | Border | Fil | Protection | Number | Alignment |i Font f| Border | Fil | Protection |
Text alignment Orientation Font: Font style: Size:
Horizontal: - Calibri Regular 14
' Cambria (Headings - - | [10 -
. *
General [=] ndent . Calibri (Bod [ |meke 11 i
Vertical: i 2 T % Agency FB Bold 12 |_|
- e Aharoni Bold Italic
Bottom El x || Tt ’ T Algerian 16
Justify distributed t . H Andalus 18
* Underline: Color:
Text contrel . None [=] | —~ | ] normal font
[ wwrap text 0 | Degrees Effects Preview
[ shrink to fit [ strikethrough
I tderge cels [ superscript AaBbCcYyZz
Right-to-eft [ subscript
Text direction:
This iz a TrueType font. The same font will be used on both your printer
Context |Z| and your screen.
[ o || cancal [ o ][ cancel
Alignment Tab Font Tab
r B
[ Format Cells m1 Format Cells m
| Nurnber | Alignment | Font | Border | Fill | Pratection | | humber | Alignment | Font | Border | Fil l—I_Protecﬁon
Presets Background Color: Pattern Color:
T | Mo Color | Automatic El
Jr CMC NN e BetenSti g
Mone Qutline  Inside OmROOO0OO0OOOsOc
Border D.DDDDDDD
- - ENEEEEEENEME
EEEEEEEEEE
EEEEEENEEEN
- Text AN EEENEN
- | Fil Effects... | | More Colors... |
| Sample
The selected border style can be applied by dicking the presets, preview
diagram or the buttons abowve.
[ ok || cancal [ ok ][ concl
Border Tab Fill Tab
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Learning Objectives:

After completion of this chapter, you should be able to:

1.
2.

3.

Learn the basics of making professional presentation for scientific work.

Manage PowerPoint2010 Environment, such as: tabs, groups, commands, Configure
PowerPoint file options and slide ...etc.

Create a slide presentation, Add and remove slides, Format slides, Enter and format
text and Format text boxes.

4. Know how to Construct and edit photo albums.
5. Create charts and tables, such as: Construct and modify tables and Insert and modify

© oo Noo

charts

Learn how to insert a video, edit it, and format its appearance.
Learn how to insert sounds into a presentation and edit them.
Apply and modify transitions between slides.

. Apply built-in, custom animations, Apply effect and path options.

10.Publishing presentations in different formats such as (PDF format).
11.Making hardcopies of presentation to fit different objectives (printing handouts,

outlines).

rJ .
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1. Introduction to PowerPoint 2010 Environment

Microsoft PowerPoint is a presentation graphics program that helps to create interactive presentations for
classroom, business, or personal use, PowerPoint allows you to construct presentations from scratch or by
using the easy to use wizard.

Quick Access Toolbar File Name.pptx Minimize — Maximize - Close
, . ; A\
' 3 «Q  Design Sarmt’i"‘i:. ations  SideShow  Redew  View = Tabs ‘—m
4 P 55~ vied <A | W] =t = 3 b= "ﬁ' B
“ <A = i 8 n
D=8 TSN =Ml 5 .
Paste New -
o J Slide ~ 3' > Styles > =~

B Z U Sahﬂ-A.-tA-\EtiI- oAl ismpesAnquuut = eating

Clipboard 1% Stides

Slide Pane

0--0

I )lnserﬂon Point ?

O

o .
U

Click to add subtitle

iy

Placeholders

Notes Pane

f
Slide# # of Slides

Normal Reading Slide Sorter~ Slide
View View View Show
Creating New Presentation
To Create a New Blank Presentation: %’T R i e
d swve Blank presentati
B saveas [
Click the File tab > Select New = Select Blank | & o
. . o Close
presentation under Available Templates and 7
Themes. It will be highlighted by default > Click
Create. New
Themes My templates u:;:’m D
ofﬁcem‘l’empl. ﬁ(_hoiﬁ(u L Create
Cla
— |
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212 IEI Layout *I
2. Home Tab E’

Slides Group slide =| ) Section ~
Slides

1. Slide Basics

Slides contain placeholders, which are areas Click to add title

on the slide that are enclosed by dotted
borders. Placeholders can contain many
different items, including text, pictures,
charts, and more. They also have thumbnail- } lcons to insert

* Clickto add text 4=} Placeholders

sized icons that represent specific commands diffirentttyptes

such as Insert Picture, Insert Chart, and Insert oreonten

Clip Art.

To add a new slide click New Slide or press

Ctrl-M.

2. Slide Layouts e el

Office Theme

The placeholders are arranged in different layouts that
can be applied to existing slides, or chosen when you
insert a new slide. A slide layout arranges your content
using different types of placeholders, depending on what - :
kind of information you might want to include in your Title Slide Title and Content | Section Header
presentation.

To Change the Layout of an Existing Slide:
1. Select the slide you wish to change.

2. Click the Layout command in the Slides group on Two Content Comparison Title Only
the Home tab. A drop down menu will appear.

3. Choose a layout from the menu. The slide will
change in the presentation.

Blank Caontent with Picture with
Caption Caption

3. Insert Tab

PowerPoint (as Word and Excel) allows you to insert Tables, Shapes, Pictures, Clipart, and Links ... etc.

JTEE - & »d @ A 4AEEwE T & &
Students Marks
| — e —
i R [Name e mmae:  baghint |
p— e - (8 -
"‘i. ™~ n L
e " " " |
|
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»
=

s S 4 Insert Hyperlink
Shlpﬂ SmartAn (haﬂ Hwevlmk Action : g — e — T
R“«Iwums‘ & | ans Animations Shide Show Review View Format
B\\Noocoa11>80 | I _| D 4dAEEZE Tt 2 & @
‘3 \/\ { } ﬁ ) a Header WordArt Date Slide Object Equillon Symbol Vd eo &udo
Lines ) § BD & Footer ‘.ﬂd&Tme MNumber S e
B s e T O - S~ |
Rectangles T
oo oGoioaoc
Basic Shapes EBana’ Applied university 7
BOANIACOQOO®® 4 =
@GOOOrL/7o0ed | Insert Hypertink L2 e
OO0O@A AN Unkto:  Text to dsplay: | <<Selection n Document>> ScreenTig....
(Jif.fm.),{ 3 E’mn B v Documents HE @
DEC TS RPR I I il f vy | Ry L pame
'g § W T '¢ QD > D:EJ :D[’j - - Data Base bb_marks_new plain
SD&A N el || — %i":}:‘:?‘
Equation Shapes Pages clif_ psF
EEETT =
O eoay .
coON®® % 6 AVID - = J I=]
el=[al®) Link Address [ oc ][ conca |
R
(a8 (28] iga] o8| 98| 53] .
Insert Chart it 3 8] 8 Lt ]|
D) ) ad) AA] B

To resize chan data range, drag lower left comer of range.
5. u--u, .

+ . -
(o ~alor & w -

SEoan aoow (o)

u H !‘—‘

fy 2 Coegory 3 Caegory &

In addition to all of the above PowerPoint offers Photo Album

.
and Media @ ‘0

insertions. Videa - Audio
Media
e 2
3.1. Photo Album Abnm Content
Msn:.‘;i::mm:
You can create a series of slides or an entire
presentation based on images you select from your | seecomes
computer. Clicking on the Photo Album tool brings | ==t
up a dialog box to select images and format the
series of slides to place in your presentation, (E3 ES [y Br===w 7=y EN Q) IR B
including frames and captions. e o & o —
Theme: z:rmm<m)mm ‘
(oo ) [Comea
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3.2. Media
To add videos and audios to your presentation.

Audio: In the slide pane of the Power Point window, select the slide onto which you wish to insert the sound
file. Choose Audio from the Media group.

= From the Insert Sound window that appears, navigate to the folder that contains your saved sound file.

= Click on the sound file you wish to insert.

= Click on the button labeled Insert.

= Power Point will insert your sound file to the slide, represented by a tiny loudspeaker icon that you can

move anywhere on your slide. —— —
0 ® b » Lbeades » Music » Sample Music . iy 3

o

Click Insert "
To Insert Clip Art Audio:
1. From the Insert tab, click the Audio drop-down arrow and select L? 9
Clip Art Audio. The Clip Art pane will appear on the right. " e
Insert Clip " ii&":::’:f
2. Enter keywords in the Search for: field and click Go. Art Audio =

3. The results will appear in the Clip Art pane. To preview an audio file, right-click the file and select
Preview/Properties.

4. A dialog box will appear, and the audio file will start playing automatically (it may take a few seconds to
load). To play it again, press the Play button.

5. When you’re finished previewing the file, click Close.

6. Once you have found the audio file that you want to use, click it to insert it into the slide.

Playing Audio File

Select the inserted Audio file the Audio Tools Tab appears in the ribbon, providing specific tools.
1. In the Audio Options group on the Playback tab, there are other options that you can set to control
how your audio file plays.

Audio ToolsTab

‘ °

w O Presentation] - Microsoft PowerPount

a ) VAV  rade Dusstion J B t1ant g
% - P hirede 0000 N TR iy RN Playback
s - (P Face O G000 e ~ . 9 v . e Tab

Editing Group Audio Options Group

= Volume: Changes the audio volume.

= Start: Controls whether the audio file starts automatically or when the mouse is clicked.

= Hide During Show: Hides the audio icon while the slide show is playing.

= Loop until Stopped: Causes the audio file to repeat until it is stopped.

= Rewind after Playing: Causes the audio file to return to the beginning when it is finished playing.
Cla

Microsoft' W™ 3
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2. In the Editing group on the Playback tab, there is option To Trim the Audio. If you add a song to a
slide, you can trim it so that it will only play one section of the song, and you can add a fade in and
fade out to smooth out the beginning and end.

w Fade Duration

il Fade In:  00.00
Trim
audio | 0dY Fade out: 00.00

a. From the Playback tab, click the Trim Audio command. The

Ar A

Trim Audio dialog box will appear. g
Trim Audio (2 [
Seeep Away.mp3 Start and End Time Duration: 00:56.824
b. Use the green and red handles to set the start time and B =
end tlme 00:56.342 = [«:}‘ \ ?‘ |!] 01:53.167 |+
Start Time End Time
Play ——— |

c. To preview the audio file, click the Play button.
d. Adjust the green and red handles again if necessary, and then click OK.

To Add a Fade In and Fade Out: _
a. On the Playback tab, locate the Fade In and Fade Out fields. " [T2 ] <y =
Trim \u‘ollv_lme =

b. Type in the desired values, or use the up and down arrows to  sudis |us Fade out 0230
adjust the times. H G

AF A

Fade In

Start the audio clip with a fade
effect for a certain number of

seconds.
3. Formatting the Audio Icon
Farmat Tabh Audio ToolsTab
Ld90 Postmond - Moowh oseort L
I 3 % ,‘ .' v - —gpm - Z Powe borter - | G bng ot « 1 gn- T 51 e it
Y Eres PR FEL R etk ne
ssdpend | * ionll APPSR 3 R tententane by . o> "
Adjust Group Picture Styles Group

By default, an audio file will show up as a speaker icon in the slide. oo \_ﬁ 5 T Compress Pictures
To change the icon to a different picture, and you can apply different _ “*° *'”

Corrections  Color  Artisti

image formatting such as Artistic Effects and Picture Styles which > < Eftects - g Reset icture -

. Adjust
are access in the Format tab
To Insert Video: "gmw : =
Organze v New folder S B O

In the slide pane of the Power Point window, select the slide | suusae videos ibray
onto which you wish to insert the video file. On the Insert
ribbon, choose Video from the Media group.

1. From the Insert Video window that appears, navigate to ’"

the folder that contains your saved video file. Mt
2. Click on the video file you wish to insert. B i — .
3. Click on the button labeled Insert. T - (Rl (o

= -
Click Insert

Video ToolsTab

Plld MO ' Presentation] - Microsoft PowerPoint
m nsert Design ¥
e t ' ! ' " =
b < &5 8 Face | 00.00 ‘&“ Lo untit Stapeed | Plavback
y e ndee W raceout: 0000 = IVTU™" 1 rice Wiite Mot Paying Rewing after Playing Iab
Editing Group Video Options Group
Cla
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4. Design Tab

The Design tab contains the groups for the tools regarding the formatting of the layoutand general look of

the document.

Home

Inset § Oesign | Transitions  Animations

ShdeShow  Review  View  Developer

1 B

Page  Shide
Setup Orientation *

XVA VA A xo R: E ! Asd | Az
lllalll lllalll ] aIll M mu NIl n _-IAL. rsamin

w_ Background Styles *

*. Hide Background Graphics

u
J Backaround

Page S'etup Group

Background Group

Themes Group Background Group

IQ Background Styles ~ I

You can also set a custom background in the Background Styles tool. [ Hide Background Graphics

Here there are some preformatted colors that you can choose.

n s \d Bactground Styles -|

1l

Background

O

LJ

| - |

]

| &

Format Background.. I

., Select Format

o

Format Backgrou

Picture Comectons -
Picture Color
demene Effects

T —

im Format

Gradent fl

peareorenren Background

Pgttern il

tade bocigreund geoiies VW T il 0w
Fill Coler

coor: [ =]

Tromparercy: |} 0% =

Cose | AppiytoMl

Reset Slide Background BRCkgl'Oll n d

Create a background of your own by selecting Format
Background. The Format Background window will appear and
allow you to select the color, gradient, picture or texture, and
transparency of the slide background.

Click on the button labeled Close in order to apply the chosen
background to the current slide only.

4 Paste Oplions

You may click Apply to All if you would like to apply the chosen )|
background to every slide in your presentation. T Publish Slides
Buler
Note: You can apply a Background Color to an entire slide by Right click on Grid and Guides...
the slide that is outside any textbox. From the pop-up menu that appears, | Layout .
select Format Background. Reset Slide
|$-j Format Background... |
V— -
Office
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5. Animations Tab

The Animations tab contains groups for the tools relating to adding custom animations to slide objects

within a slide. E T——— - )
Home et Desgn Toostions [ Aninstons | SideShow  Redew  View o
Tr— ‘ ﬂi J ination Pne " Reouder eimation
‘ 7 <
Peiew B Nooe | loper e fyh  Reath St Wipe Shapt  Wheel - M :

Adding animation
a) On your slide you have text boxes, images or

. . . Slide Sh Review View Form €
charts (called Slide Objects). Click once on one x |t Reorar A
of the Slide Objects (text or images) to select it. s |-
b) In the Animations tab click Add Animation to % Kk K K [N
bring up a listing of common effects to add. Asaleg applied universt 7 O T8 T T
c) You can also access a complete listing of " = 0 e il
animations for Entrance, Emphasis, or Exit = I . 1
effects by selecting More Entrance /Emphasis r W ¥ K K
/Exit Effects. k
d) Once you have selected this option (such as k "
More Entrance Effects), the appropriate palette i
will appear on the right side of the slide.
e) Now you can single click on any animation and
preview the effect on the selected object. This
window also shows the full range of effects that are available. Click [ o )
OK to add the effect. pacic E
_ ) i 3 sinds
NOTE: You can only animate one slide at a time 5 500 S Chedterbord
e Cirde Fy Diamond
¥ Dissolve In fFIy In =
Once the animation has been applied, you can click on the Animation Pane i:‘*:“ i ;:'“;
- - - - - - - - andom Bars pli
toql to customize the applied animation in terms of timing, triggers for the || ... & e
ani matl on. Fe Wheel S wipe |
Subtle
fdons Animations Slide Show Review View Format [~ o ﬂExpand * Fade
) = b Start: On Click - Reorder Animation ¥ swivel # z00m
K o - ;fr_ct z ;ﬂTrlgger' @ Duration:  Auto : love Earlie Moderate
- FlyIn Float In *| options - Ammatllog‘l' *;':A:ml?nat:n Painter | (B Delay: GCI‘CIl?r . : ¥ Move Later fBasic Zoom fCenber Revolve
I - = = e A:imation Pane - X f Float Down ﬁFIDatUp =z
[¥] preview Effect
Ll 13 TextBox 6: Al-... [»
was constructed in 1887 28 TextBoxS:It... [ |
Click to add notes ~ Seconds »| «[0] * 2 »
m |: 4| Re-Order (¥
|[ME]es B8 = aam (=)L) (+) @—
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6. Transitions Tab

In the Transition tab, you can to set up effects for transitioning from one slide to the next. The default

transition doesn’t involve any special effects.

- o Inset

None

=

i
B |
Push

....

Select the slide from the thumbnails on the left.

>3

{ Sound: MNoSound, * Advance Slide
O Durstion: 0200 -
140 Apoly To All Mter. 000000

2. Click on the selection to apply the effect on the current slide. The effect occurs between the selected

and previous slide.

Presentatiort - Microsoft PowerPoint

£ 4 Sond NoSund -

Tl 3| F 3 -
E L] o | R

Effedt

Rl EndomBas  Swpe  Unawr (o 5 B S
g ™ Ogtions+ 38 ApplyTo Al

Achian
& on

ter 000000

Al-Balga" Applied university

|It was constructed in 1997 ‘

3. You can then select Effect Options for the transition and slide advancement settings in the tools to
the right of the transitions. Click Apply to All to apply the settings to all slides.

7. Slideshow Tab

None

Al-Balga’ Applied university

I It was constructed in 1997

The Slideshow tab contains tools that allow you to select how your presentation will be displayed.

7.1. Start Slide Show group
To view the slide show from the beginning or from a current selected slide.

=1
)
From
Beginning Current Slide

= 1l
Y | @ &I
Broadcast Custom

Slide Show Slide Show ~
Start Slide Show

From

72

Cla
o |
Office

2010



Chapter 5

Microsoft PowerPoint 2010

7.2. Set Up group

- x 7| Play Narrations
g - |_|{f’)j L‘“_L:J Y
. W Use Timings
Set Up Hide Rehearse Record slide )
Slide Show Slide  Timings  Show~- ¥/ Show Media Controls
Set Up

» Rehearse Timings means (start a full-screen slide show in which you can rehearse your
presentation. The amount of time you spend on each slide is recorded and you can save those

timings to run the show automatically in the future).

» Hide Slides: Hiding a slide will keep it in the file, but
presentation.

7.3. Navigating within your Slide Show

While you are presenting your slides during a presentation, you

it will not show when you view the

will often want to move forward and

backward among your slides, or to display a particular slide. Power Point's Presentation toolbar can help

you navigate within your presentation during your slide show.

bottom left corner of the slide.

Once you begin your slide show, locate the Presentation toolbar in the

To move to the next slide, click on the right facing arrow.

To return to the previous slide, click on the left facing arrow.

)
[

To navigate to a slide that is not immediately before or after the current slide: Click on the

presentation menu button, then from the Go to slide submenu, click on the name of the slide you

wish to display.

Go to Slide 1 Slide 1

2 Slide 3
3 Slide 2
Sgreen

Help

End Show

To end your slide show: Click on the presentation menu button. Then select End Show.

Presentation Menu

Button
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You can also use the following keyboard buttons to navigate during your slide show presentation.

If you want to.. Press the...
Display the next slide — (right-facing arrow) key
(down-facing arrow) key
Enter key
Space bar key
Display the previous slide «— (left-facing arrow) key
1 (up-facing arrow) key
Blank the screen B key
Make the screen white W key
End your slide show ESC key
Ly Arrow
e You may find it useful to emphasize content on your ¢ & A —
slide without turning away from your audience to face < %"
the classroom screen. Power Point's Ink annotation eeler . I
tool allows you to do this with your cursor. «ANRNERES
Standard Colors
Arrow Options » | |:| EEEER
rd

From the menu that appears, you can see the Ink annotation tool options.

If you want to.. Click on...

Draw a line #| Pen

Highlight without covering the element # Highlighter

To change the Pen's color Ink Color >
To return to the arrow when you have lg  Arrow

finished your annotation

Power Point will allow you to save any annotation that you have made during your presentation. To do so:

L]

Click on the button labeled Keep from the window that | Miresoft PowerPoint
appears when you end your slide show. Or click on the button

labeled Discard if you do not wish to save these annotation. Iy Bovounenttokeep your ik amnotations?
| Keep | [ Discard
8. View Tab
Contains groups with tools for manipulating the viewing a document.
8.1. Presentation Views Group
: s View Tab
Presentation Views
Home Insert Design Transition Animations Slide Show Review
| H - 1 7] Ruler \ = F @ color
f:ormil Slide Notes "‘v:.‘-:ITn‘.;- Slide Hand ::‘ut Notes one = Zoom rI!‘:':‘ - G =
S e Page Viev Master Maste Master suides Nindo - Elack 1 Whit
Cla
wirosor LD
Office
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1. Normal View contains three panes: the outline pane | =, the slide pane ~' , and the notes pane.
This view is used to create and edit slides.

2. Slide Sorter View displays miniature versions of a slide for changing the transition, or reorder slides
by dragging and dropping them (you can also use the cut and paste buttons on the Home tab to
move slide from one position to another in your presentation). Also you can set the timing for the

slide show.
3. Notes Page View shows slide with note section below. Allows you | 2=} S5 = || 12
to enter information regarding a slide for either distribution Or |mermail| siide |notes |Reading
Sorter | Page Wiew
presenter nOteS- Presentation Views
Transitions Slide Shov R 7
Y B e | B @B
Notes1of 2 | “Office Theme é Arabic fordan) ‘ |BEm P 7% +_J;

4. Reading View shows the presentation as a slide show that fits in the window.

8.2. Masters Views group

Used to help develop consistency in your presentation by adding a new =] J J

. R . . . Slide JHandout Motes
style/format to one slide then have it apply to all slides in the presentation. Master] Master Master
With the Slide Master feature you can: Master Views

e Change the default typeface style and color for all slides in a presentation.
e Add a company logo, name, department or date to a presentation.
e Add headers, footers and notes to all slides in a presentation.

To change to a Slide Master, click on the Slide Master Button in the Master Views group. Make desired
changes then click on the Close Master View button to finish.

RlH9-0 = Presentationl - Microsoft PowerPaint [= ] E [
E Slide Master | Home  Inset  Transitions eview  View = @
olors - N
8| Background Styles h x|
J J A Rename J onts * J
Insert Slide  Insert Master Page Slide Close
Master  Layout 'S Presemve  jayout Ectshg Setup Orientation~ | Master View
Edit Master Master Layout Background Page Setup Close
-
’ E
Click to edit Master title style
Click to edit Master text styles -+
Second level =
Third level *
Fourth level —
Fifth level »
=
Slide Ma: Theme- | &5 Arabic pordan) | | @ =T a9 (-0 + 5
Cla
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9. Ending Work

When you’ve finished your work, certainly you’ll want to have a soft copy (saved in your computer) or a
hard copy (printed) for your presentation.

9.1. Saving a presentation

Click on the File Tab then select:
Save: To save the presentation with
the name you want in pptx format.

Or

Save as: To save the presentation in
other format (e.g. pdf) or version
(e.g. Power point 97-2003). e oo+ [ame ] [ Gance

Save as type:

9.2. Printing a presentation

PRI T Prisatatond s Wecroseh Fowaond I R |
Click on the File Tab then select Print | s s oo oo i e @
from the File Tab to choose from a :: & |
variety of printing options. o e | T E
into Printer
recert Print 1@7’7’:4"'\'3”"*;""3‘0 = e
1) Under Print All Slides choose, - 4 T
e All Slides: to print all slides. [E{ - _
e Current Slide: to print only the Seeasend oo
slide that is currently displayed. . Bzl .
e Range of Slides: to print = comes -
specific slides by number. i.e., -~ S
2-6. e 1 o3 M= ST |

2) Under Full Page Slides, you can choose Handouts so that your audience and take a printed copy of
your presentation with them. Here you can choose how many slides per page.

.a' Home Insert Print Layout Review View Q
i save L4 J 3
& swve s Full Page Slides Notes Pages Outline
Handouts
; Open )
& Op | _J —]
. —J
B Quce 15lide 2Sudes 3 Shdes o
Info | ‘ 4
4 Slides Horizonta! 6 Slides Horizontal 9 Stides Horizontal \,, —_—
Recent »
| .
= = | 3 Slides per
New 4 SHdesVertical 6 Siides Vertical | 9 Slides Vertical ———
3 V| Frame Slides Pages a e
v S —
% Scale 1o Fit Paper . \ —
~ —
4 |
Save & Send High Quatity A4 )
4"/
o~
Help 3 Sides R’ —
Handouts (3 siides per page) E——
2] Options
Collated —_—
XS ‘J‘L‘i.‘"" ¥
\J Portrait Orientation v
Color * o
‘ vl 41 of1) 7% (= i
Cln
Microsoft ad
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Appendix
PowerPoint 2010 Assignment
Create a PowerPoint presentation that consists of 4 slides and includes the following skills:
First of all:

- Set a theme for your presentation
- Set a background

- Use of the master slide

- Use of timed slides

In slide 1:
- Insert a title and subtitle
In slide 2:

- Insert a title and three bullets
- Insert an image
- Set up transitions

In slide 3:

- Insert sound
- Insert video

In slide 4:

- Insert a shape
- Use a hyperlink
- Use custom animation

Adding Slide Headers and Footers

- Click the Insert tab on the Ribbon and click Header & Footer in the Text group. Click the
Date and time check box. Click the Update automatically list arrow and select one of the
options.

- Click the Slide number check box, click the Footer check box, and type Your Name.
Click the don't show on title slide check box and click Apply to All.

- To center, move, or format the Footer text with a different font, font color, or font size, click
on the placeholder and make the changes.

Ca

77 2010



Chapter 6

Internet and Computer Networks

Learning Objectives:

After completion of this chapter, you should be able to:

1.
2.

3.
4.

Learning the basic concepts of networks, network types, threats and viruses.
Describe the device, connection & provider options for connecting to the Internet, as
well as some considerations to keep in mind while selecting an ISP.

Learning the main functionalities of the Internet Explorer 11.0.2.

Leaning some basic internet-browsing skills like web search, web pages saving,
images saving and other skills.

Learning how to create a new email account.

Learning the most common social media network.
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1. What is a Network?

A network consists of two or more computers that are linked in order to share programs, resources (such as
printers), exchange files, or allow electronic communications. The computers on a network may be linked
through cables, telephone lines, radio waves, satellites, or infrared light beams.

Common types of networks include:

e Local Area Network (LAN)

e Wide Area Network (WAN)

e Wireless LAN (WLAN)

e Metropolitan Area Networks (MAN)
e Wireless WAN (WWAN)

1.1. Local Area Network

A Local Area Network (LAN) is a network that is confined to a relatively small area. It is generally limited
to a geographic area such as a writing lab, school, or building.

1.2. Wireless Local Area Network

The term ‘wireless network' refers to two or more computers communicating using standard
network rules or protocols, but without the use of cabling to connect the computers together.
Instead, the computers use wireless radio signals to send information from one to the other. A
wireless local area network (WLAN) consists of two key components:

e A wireless access point (WAP) (also called a Base station)

e And a wireless card. &

Wireless Access point or Wireless Basestation

P
L

WIF i Fi is a popular technology that allows an electronic device to exchange data or connect to the
internet wirelessly using radio waves.

Many devices can use Wi-Fi, e.g. personal computers, video-game consoles, smartphones, some digital
cameras, tablet computers and digital audio players.

1.3. Metropolitan Area Network (MAN)

A (MAN) is a large computer network that spans a metropolitan area or campus. Its geographic scope falls
between a WAN and LAN. MANSs provide Internet connectivity for LANs in a metropolitan region, and
connect them to wider area networks like the Internet.
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1.4. Wide Area Network

Wide Area Networks (WANS) connect networks in larger geographic areas, such as whole world. Dedicated
transoceanic cabling or satellite uplinks may be used to connect this type of global network.

WANSs as computer networking technologies used to transmit data over long distances, and between
different LANs, MANs and other localized computer networking architectures. The Internet can be
considered a WAN as well, and is used by businesses, governments, organizations, and individuals for
almost any purpose imaginable.

1.5. Wireless Wide Area Network

Wireless WAN is a wide area network in which separate areas of coverage or cells are connected wirelessly
to provide service to a large geographic area.

A WWAN often differs from wireless local area network (WLAN) by using mobile telecommunication
cellular network technologies such as WiMAX (often called a wireless metropolitan area network or
WMAN) and cellular digital packet data (CDPD) to transfer data.

These technologies are offered regionally, nationwide, or even globally and are provided by a Wireless
Service Provider for example Zain, Orange and Umniah in Jordan.

2. Network Drawback (Computer Viruses)

Computer Viruses are the most network drawback. Viruses are becoming more and g\\‘ \.\<{‘
more sophisticated and employ many different methods of spreading. While email b;ﬁ?ﬁ‘%

has been the primary method for the spread of these recent computer viruses, it is not ‘A | N
the only method.

A computer virus can enter a network by CD, floppy disk, internet download, file transfer and file sharing
programs, or by remote users connecting directly to the corporate network with an infected PC. Once
computer viruses gets into a network it can spread to computer in multiple ways.

2.1. Common Types of Computer Viruses

e A macro virus is associated with application software like word and excel. When opening the
infected document, macro virus is loaded into main memory and destroys the data stored in hard disk

e A worm is also a destructive program that fills a computer system with self-replicating information,
clogging the system so that its operations are slowed down or stopped

e Atime bomb is a virus program that performs an activity on a particular date

e Trojan horse is a destructive program. It usually pretends as computer games or application
software. If executed, computer system will be damaged.
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2.2. Antivirus software

The Antivirus software protects the computer from computer viruses. The following figure represents the
common types.

McAfee Kaspersky

——

« W
€ KNTIVIRUS SIAVG

¥ PLUS
l; 208 y Internet
Security

2.3. Preventing from virus infection

e Always update your anti-virus software at least weekly.

e Get trained on your computer's anti-virus software and use it.
e Have multiple backups of important files. This lowers the chance that all are infected.
e Forget opening unexpected e-mail attachments, even if they're from friends.

e Scan internet downloads.

e Use firewall to protect your computer and network.

3. Internet Overview
3.1. What is the Internet?

The Internet (also known as the Net) is a world-wide electronic network that enables many independent
computer networks to connect together by using a common connection, called an Internet Protocol (IP)
which will dynamically and intelligently figure out a way to get data from one point to another across
multiple ISPs.

3.2. How do | access the Internet?

A computer is “hooked up” to the Internet when the owner subscribes to an Internet Service Provider
(ISP) and has a browser installed on to the computer. An ISP is a company that will allow you to use their
computer connections to access the Internet for a fee.

To be able to access all the internet has to offer:

1. You will need an internet account with an internet service provider (ISP). ISPs like Orange provide
these accounts usually for a monthly fee, much like a phone service. You might also need to have
somebody come and install a line into your home.

2. You will also need what’s called a modem (or modem router). Your ISP will be able to sell you a
modem when you set up an account with them.

3. Once you have an account and a modem set up (the ISP will guide you through setting up the
modem), you just have to plug your computer into the modem to access the internet.
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‘What you need to
connect to the Internet?

I\ q
I = E -' . _

= 3.Computer

Interﬁet 1.ISP 2. Modem

There are a number of different ways to access the internet. There are five major types of internet access:

1. Old fashioned dial-up. You can’t make or receive phone calls while connected via dial-up to the
internet.

2. ADSL, which uses a special modem to transform your existing phone line into a high-speed phone
line. Because it is a broadband connection, you can chat on the phone at the same time you use the
internet. ADSL is the most common type of broadband connection and the easiest to set up at home.
Most ADSL services require that you have a phone service, but there are also so-called ‘naked’ DSL
services that require no phone service.

3. 3G/4G which uses mobile phone networks to connect you to the internet.

4. Satellite, which transmits data from satellites.

Not all services are available in all areas. Your ISP will tell you which ones are available to you. While
different internet connection services have strengths and weaknesses, they all connect you to the same
internet.

3.3. Different Speeds and Quotas

When signing up for an internet account, you may be dazzled by the number of different and confusing
options available.
There are different speeds and different monthly quotas available on different accounts.

e Speeds are measured in kilobits per second (Kbps) or megabits per second (Mbps), with 1mbps
equal to 1000kbps. A dial-up connection works at 56Kbps, while ADSL can go as fast as 24Mbps —
more than 400 times faster than dial-up.

e The monthly download quota determines the volume of data and media you can download before
your ISP either cuts you off, slows down your connection or charges you extra (depending on the
specifics of your internet account agreement).

e Volumes are measured in gigabytes (GB) and sometimes megabytes (MB), where one GB is equal to
1000MB. You’re not likely to go over your limit just looking at web pages and sending emails, but if
you watch a lot of online videos you might reach your monthly limit.

4. The Internet and Everyday Life

New uses for the internet are being invented every day. There are literally hundreds of millions of web pages
and services available. It’s very easy to sink hours, days, weeks and months exploring all the internet has to
offer.
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The following uses are the most common:
1. Sending emails, which are letters that can be sent for free to anyone and arrive instantly.
2. Looking up news, weather, health information and sports results, government information and forms.
3. Searching for information on just about any topic, such as Flight timetables, phone numbers and just
about anything else you can think of!
Doing all your banking, taxes and business online.
Sharing your photo and video collection, and seeing the shared collections of others.
Talking or video chatting with online friends — at any time, for free.
Participating in discussions on topics you find interesting, with people from around the world.
Downloading and watching movies, reading book reviews or watching sports.
E-commerce, buying and selling goods from online stores.

© oo N gk

5. The Browser

An Internet browser is a computer application that will give you access to the Internet and navigate the
World Wide Web.

The World Wide Web (WWW), also known as the Web, is made up of millions of documents called web
pages. Web pages can include text, pictures, video and sound. Most organizations on the Web have sets of
pages, which are linked together. These sets of pages are called websites. You can use the Web to get up-to-
date information about almost any subject.

5.1. Internet browsers Examples

Internet Safari Mozilla o Netscape Google
Explorer FireFox navigator Chrome

e e @
T \
3 o O H ¢
Each of these Internet browsers will interpret the computer code in web sites, in order to display text and

graphics (on these sites), provide encryption security, play video and music, and display links to other web
pages.

5.2. Website Address

A domain name is the root web address for a Website. Domain names function on the Internet in a manner
similar to a physical address in the physical world. Each part of the domain name provides specific
information. These pieces of information enable web browsers to locate the web page. The naming system is
closely regulated in order to prevent confusion or duplicate addresses.

An Internet address is in alphabetic form. Domain names must have at least two parts:

e the part on the left which names the organization (website name),
e And the part on the right which identifies the highest subdomain (extension), such as the country or
the type of organization.
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Extension

Stands for World Wide Web —™———— ‘/‘/

http://www.bau.edu.jo

Name of site

"bau.edu.jo" bau is the organization and edu.jo identifies it as an educational institution in the Jordan.
There are only a limited number of such highest subdomains. For example:

subdomain name usual meaning

.ac university etc in UK

.CO business in UK

.com commercial business

.edu Educational institutions
.gov Government site anywhere
.0rg Organizations (nonprofit)

6. Internet Explorer Browser

First, you need to open the web browser. That means clicking the Internet Explorer icon. When the
program starts, it will automatically go to a home page. It is a web page that is configured to be displayed
first when a Web browser is opened.

Adverising Business

ol ol e

0

About

© 0

Google o

Jordan

Google Search I'm Feeling Lucky
Melson Roliniahla Mandela, 1918 — 2013 o
Google jo offered in- G

MNew Privacy & Terms Settings

—_re g
hitps://vigugoogleio/ €L - @ CY ) Guugle CD T o i53
File] Edit gView Favorres Tools Help
{:‘5 Sugclested Sites w ﬂ Amazin & eBay Toshiba Places a Welf Slice Gallery « & < > [ éa.' &' '@'J' ™ ®' ”
I +Mohammad Gmall  Images H [m] Shara -

(7

Google.com

I ®s0% ~

When the browser opens, you’ll see buttons, icons and headings representing various features, tools, search
and navigation controls. From left to right:
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Back: Go back to a previously viewed web page.
Forward: Go forward to a previously viewed web page.

Address bar: Enter a website address or a search term here to find what you’re looking for. It
is also called as Uniform Resource Locator (URL).

Search engine selector: Click the adjacent down-arrow to choose  preferred search
engine (google, bing, yahoo)

The AutoComplete feature in Internet Explorer lets you more quickly fill out web forms
and go to websites you have visited in the past.

Security report: clicking this icon displays a report describing the certificate used to
encrypt the connection and the certifying authority that issued the certificate. The security
report also provides links to more detailed information.

Refresh: Reloads web page, so you know you’re looking at the most current version.

Tab: Shows the title of the website in the open window.

Click on that icon a new tab will appear. You can go to any address you like in this new tab.

3.

Home: Reverts to web browser’s home page, the one you see when you first start Internet
Explorer.

Favorites: Displays websites saved as favorites. When you click on Add to Favorites.
The current web page will now be added to your Favorites list. Whenever you click on
Favorites again, you will see it.

Tools: Access zoom, print, internet options and other functions.

Menu bar: can be turned on or off in Windows Internet Explorer. That is representing
various features and functions.

Favorites bar: that enables one-click access to your favorite web sites.

Command bar: offers easy access to almost any setting or feature in Internet Explorer. You
can customize the Command bar buttons to suit your preferences.

Status bar: it displays messages such as a webpage's download progress.
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7. Changing Your Home Page
Home page is the page that the browser opens to whenever you start it up. To change your Home page.

1. First you go to the web page that you’d like to set as your

home. = -
2. Now right-click on the Home button. A drop-down menu {0t 5.8 653
will appear. | ¥ Menubar

v Favorites bar
v | Command bar

3. Move your mouse to Add or Change Home Page and 7 | Status bar
left-click. 1 AVG Security Toolbar
a. Select Use this Web Page as Your Only Home Page. Google Toolbar

b. You can have several pages as your home page; with
each page open in its own tab. Select Add this
Webpage to your Home Page Tabs.

v Lock the toolbars

Show tabs on a separate row

Add or change home page

8. Search Engine

A search engine is a website that you can use to look up web pages.
There are many different types of search engines made by different companies, the most popular ones are:
e www.bing.com Bing is Microsoft’s alternative to Google.

e www.google.comThe home page of Google, the world’s largest search provider.
e www.yahoo.com

But the most popular is Google. To search the internet with Google, type www.google.com into the Address
bar of your web browser.

—

a' , )l = www.google.com

e

The Google main page will appear. In the middle of the page is the Google Search bar.

e B hitps://unn.googlejo, P - @< | B coogle ‘ | PN AT

2 & suggested Sites + [EY Amazon ¥ eBay @ Toshiba Places &) Web Slice Gallery + & - - v [ B B @

Find: [ | Previous Next | [[7] Options ~ |

Jordan

GO ]_e Google Search Bar
3& 7

Google Search I'm Feeling Lucky

Google.jo offered in: s It

Advertising  Business  About New Privacy & Terms ~ Settings ~ Google.com W
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How to read search results

Google's goal is to provide you with results that are clear and easy to read. The diagram below points out
four features that are important to understanding the search results page.

GOUgle aooge e

Web

1
Google «—

Enables users to search the Web, Usenet, and images. Features include PageRank. caching
and translation of results, and an option to find similar pages
........... google cony - 6k - Ca 2

\

Google Image Search 3

The most comprehensive image search on the web. Advertising Programs - Business
Solutions - About Google ©2007 Google

images google com/ - Bk

Google Groups \ 4

Enables users to search and browse the Usenet archives which consist of over 700 million
messages. and post new comments
groups google com/ - 22k -

The title: The first line of any search result is the title of the webpage.
The snippet: A description of or an excerpt from the webpage.
The URL.: The webpage's address.

Cached link: A link to an earlier version of this page. Click here if the page you wanted isn't
available.

el A

9. Saving or Copying images

1. Select the image - right click and then choose either:
Copy then paste it in the desired place.
or

Save Picture as then save it in the desired location so you can find it later.

€ savehs ==
@kal_i b+ Computer b + 42| [ Search Computer ol
Open link in new tab Organize + - @
ink i = Download: 2 :
Open link in new window 8 Downlosds 4 Hard Disk Drives (1)
IR S %l Recent Places
Open link in incognite window p 53425670002 (C:)
Save link as... i Libraries 395 GB free of 450 GB
Copy link address [ Documents 4 Devices with Removable Storage (1)
Py 2 o Music |
- =] Pictures &IE DD RW Drive (D)
Save image as... B videos =
Copy image URL
Ry imag 8 Computer L4
Copy image & s3K2567D002 (C:

Open image in new tab
Print... File name: Harga Laptop Toshiba o
Save as type: [JPEG Image v]

Inspect element

10. Saving a web page

Choose File > Save As menu item. In the dialog box that opens, you have several file types option. Select
your option for saving the page as a different file-type.
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11. Secure and Unsecure Web Sites

Security is an important issue on the Internet, particularly when banking and shopping. Your confidential
information such as passwords, financial information, or credit card can be accessed by other people if you
don’t make sure your transmission is secure.

Normal http web pages (pages where the address begins with http://) are not secure. These sites are fine
for general use, but should not be used to transmit personal or financial information.

e WD /maktoob.yahoo.com/?p=us 0~ ?J s Yahoo

However, https web pages (pages where the address begins with https://) are secure. Https web pages
transmit information in secure language, and no one can interfere with these sites. They are safe to use to
transmit personal or financial information (as long as the company or institution is reputable).

//onlinziiabank.com.jo/ Con O = @ Identified by .. & | 2 Welcome to IAB Connect ¢ |

When visiting a site that requires a login, it is always a good idea to log off before you leave the computer,
especially if the computer you are using is in a public place, although most secure sites will log you
automatically after a certain period of inactivity.

12. Disadvantages of using the Internet

You should be cautious about the following when using the Internet.

e Personal Information: If you use the Internet, other people can access your personal information such
as your name, address, etc. If you use a credit card to shop online, then your credit card information may
be stolen.

e Offensive material: There are thousands of sites on the Internet that can be easily found and this need to
be considered when letting children use the Internet.

e Spamming: You may receive spam when using e-mail. Spam is unsolicited E-mail in bulk, which serve
no purpose and unnecessarily slow down the entire Internet.

e Viruses and spyware: Viruses and spyware can spread rapidly over the Internet. Make sure that you
have anti-virus and anti-spyware software installed on your computer and keep it up-to-date.

e Hackers: Hackers are people who access a computer system without permission. They can link up their
own computer to networks, and open private files. By reading or changing the information in these files,
they may be able to misuse your personal information..
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13. Sign up using Yahoo Mail

To create an email account in Yahoo mail:

1. Go to this link, mail.yahoo.com. Or go to Yahoo website (www.yahoo.com). Then click on Mail icon,
Fill in the required fields and read on the terms and agreements. After accepting all the g ..
terms and agreements you will automatically be able to open your Yahoo account.

. YAHOQO!
2. Click on Create New Account button to start.

[

Password

3. The Sign up window will appear. Fill in the required fields and read on the
terms and agreements.

+ Keep me signed in

\:ﬁw[_ipmgf o I can't access my account
Help Click here
Slgn up c:eateNewAcenunt
P S —— Sign in with Facebook or Google
— |underscores, and one dot
(.) are allowed.
1 Password Rules :
o # 8-32 characters
= - 982 #upper and ‘
lowercase letters
#numbers
= - +362
4. After entering your information click on Create account button.
YAHOO" {2t Yahoo Msktoch | Help
MAKTOOB Lglis
5. After accepting all the terms and Sign up
agreements you will automatically be
able to open your Yahoo account. Al Anmed
aliahmehz3
= - +962 799999999
15 April 1990
Male
= - +962 778888585
| =gree to the Yahoo Terms and Privacy including Cookie Use.
2. g
K~
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Appendix

Social media networks

1) Facebook

& https://www.facebook.com

Facebook helps you connect and share with
the people in your life.
3. --X
f e 2
2 A
L
X p & 3 §

2) Twitter

Sign Up

It’s free and always will be.

First Name Last Name

Your Email
Re-enter Email

New Password

Birthday
Month E]

Why do T need to provide my
Day[x] | vear =] | S

O Female © Male

By cicking Sign Up, you agree to our Terms and that you have
read our Data Use Policy, induding our Cookie Use.

o

|‘ https://twitter.com/signup

Join Twitter today.

Full name

Email address

Create a password

Choose your username

Enter your first and last name

What's your email address?

6 characters or mare! Be tricky.

Don't worry, you can change it later.

Keep me signed-in on this computer

[# Tailor Twitter based on my recent websits visits Lsarn mare

By clicking the button, you agree to the terms below:

These Terms of Service ("TErMS”) gOVEM your access to and use of the
services, including our various websites, SMS, APls, email notifications

Create my account
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